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1.0 INTRODUCTION 

1.1 IDENTIFICATION 

This User’s Manual supports the functional operation of the Content Planning Module (CPM) 

5.0 software. The CPM is a key component of the Navy’s Integrated Learning Environment 

(ILE). 

1.2 SYSTEM OVERVIEW 

The CPM supports planning and management of content intended for the ILE. Major functions 

include: development of Job Duty Task Analysis (JDTA) information, building of learning 

objectives planning, managing and executing of content projects, supporting content 

development workflow and reporting requirements, data exchange and linking with other 

systems. In addition the CPM supports Centers in the areas of: event management, messages and 

announcements. The CPM supports the reuse and repurposing of ILE content by sharing the 

JDTA items, learning objectives, course outline of instruction and learning object structure 

entered by Centers and sharing project information. The CPM is designed to support 

NAVEDTRA 136 and related policy guidance. The system will return the user to the last 

location accessed when logging on. The user will also be taken to the last position accessed 

within a given tab when moving from tab to tab. 

The CPM application compliments the current ILE system by: 

1. Enabling the connection of learning content to validated requirements. 

2. Enabling the building of integrated learning objectives per the ILE guidance. 

3. Planning and managing content development projects. 

4. Supporting content development workflow and reporting requirements. 

5. Supporting data exchange with other systems via Navy owned repositories.  

The role the CPM plays in that process as depicted in Figure 1-1. 
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Figure 1-1. CPM and LO Module in the ILE Architecture 

The Navy captures requirements as JDTA items and associated Knowledge, Skills, Abilities, 

Tools, and Resources (KSATRs) in CPM. 

The CPM allows you to create a Curriculum Outline of Instruction (COI) for a course, comprised 

of Modules, Lessons and Sections that are linked to the JDTA items. 

 In a Course you will select one or more Modules 

 In a Module you will select one or more Lessons. 

 In a Lesson you will create the Terminal Objective and outline one or more Sections that 

support the Lesson. 

 In a Section you will create the Enabling Objective. 

These objectives serve as the basis for developing ILE-compliant Lessons and Sections. 

When the Learning Objectives have been completed, they will be linked to their corresponding 

JDTA items. 
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1.3 DOCUMENT OVERVIEW 

This document describes the functional capabilities for the CPM application. It is based on the 

results of an analysis of current ILE training-related processes and operations. 

This document is organized as follows: 

Chapter 1 – INTRODUCTION: Provides a full identification of the CPM application, a 

brief statement of the purpose of the application, registration information, 

summary of the document contents, and a description of user account 

management and privileges. 

Chapter 2 – HOME: Opens automatically on login. From the Homepage the CPM user has 

the ability to view their assigned Project titles, System Announcements, 

Tasks, Messages, and Events. Using the Homepage menu items the CPM user 

can: 

o Create/Edit/Delete Events, 

o Create, Reply, Forward and Delete Messages, 

o Create/Edit/Delete Assignments 

o Edit personal Profile, 

o View System Users information, and 

o Change Password. 

Chapter 3 – Data:  The data tab provides an area where the Administrator, or those with 

specific privileges, can manage data elements for: 

o Platforms, Systems, Subsystems, Components, Non-Equipment, 

Environments, Tools, Resources, Verbs, Conditions, and Standards. 

Chapter 4 - OCCSTDs: The OCCSTDs tab is where Occupational Standard information 

can be added, viewed or edited. 

Chapter 5 – JDTA: The JDTA tab provides an area where skills and performance data 

JDTA can be viewed. 

Chapter 6 – Projects: The Projects tab provides an area where: projects can be created and 

managed, Training Project Plan (TPP) and Training Course Control 

Documents (TCCD) data can be entered, JDTA can be selected for a project, 

Curriculum Outline of Instruction (COI) can be developed and Reports can be 

displayed. 

Chapter 7 – Reports: The Reports tab provides a place to select and run reports on CPM 

data. 

Chapter 8 - Resources: The Resources tab provides an area where different types of 

resources can be added to the database. 

Chapter 9 - Admin: The Admin tab provides an area where the System and Center 

Administrators can add and edit CPM User information, identify User and 
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Project Roles, identify Centers, edit Training Task Analysis (TTA) Data and 

create, edit, print and delete announcements. 

1.4 REFERENCED DOCUMENTS 

The following documents were used as references in preparing this specification: 

 ILE Policy Guidance and Specification documentation from 

http://www.netc.navy.mil/ile/ 

 NAVEDTRA 132 Navy School Testing Program Management Manual 

 NAVEDTRA 136 from http://www.netc.navy.mil/ile/ 

 NAVEDTRA 137 Job Duty Task Analysis Policy 

 Clark, R.C. Developing Technical Training: A Structured Approach for Developing 

Classroom and Computer-Based Instructional Materials. 2nd ed. Silver Spring, MD: 

International Society for Performance Improvement, 1999. 

  

http://www.netc.navy.mil/ile/
http://navyile.fedsun.navy.mil/netcile/jsp/mainframeILE.jsp
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1.5 CREATING A CPM ACCOUNT 

Accessing the https://cpm-aim.ncdc.navy.mil web page will open the CPM login page. For those 

that do not have a login click on ‘Don’t have an account? Create One! 

To create a CPM account fill-in the fields on the Create Account screen, the fields are as follows: 

 My Information Section 

o Type* - Type of user, dropdown menu to select either Civilian, Contractor, or 

Military. Civilian refers to civilian government employees.  

o EDI - not editable 

o First Name* - User's first name 

o Last Name* - User's last name 

o Rank/Rate - Rank and rate if Type selected is Military. 

o Title - User's title if Type selected is Civilian or Contractor. 

o Email* - User's email address. 

o Phone* - User's phone number including area code. 

o DSN - User's DSN if appropriate. 

o UIC* - User's Unit Identification Code if Military or Civilian. 

 My Supervisor Section 

o Name* - Name of the user's supervisor. 

o Email* - Email of the user's supervisor. 

o Phone - Phone number of the user's supervisor. 

 My Center POC/LSO Section 

o Name* - Name of the user's Point of Contact or Learning Standards Officer.  

o Email* - Email of the user's Point of Contact or Learning Standards Officer.  

o Phone - Phone number of the user's Point of Contact or Learning Standards Officer. 

 Project Information Section 

o Centers* - This is a hyperlink to a list of available Centers, select the Center and role 

the user is requesting access to. 

o Justification for Access* - Explain why the user needs access to CPM. 

o Project Ending Date - The data the project ends and the user will no longer require 

access to CPM. 

 Contract Information Section (only for Contractors) 

o Project* - The official project name. 

o Contract Number* - The contract number the user will be working under. 
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o CAC Expiration Date* - The expiration date of the user's CAC. 

 Government Sponsor Section (only for Contractors) 

The project lead who is assigning/approving the work for the project the person is 

working on.  This is at the Center level and a government person. 

o Name* - Name of the user's government sponsor. 

o Email* - Email of the user's government sponsor. 

o Phone - Phone number of the user's government sponsor. 

 Additional Information Section 

The information provided is only informational, if training or Citrix accounts are required 

they must be requested separately through the appropriate contacts (check 

http://aim.carleycorp.com for more information). 

o Comments/Additional Info - Any additional information that may be appropriate. 

o Request for AIM Training* - Drop-down menu to select Yes to request AIM 

training or No to not request AIM training. 

o Do you have or plan on obtaining a CITRIX AIM I/II account* - Drop-down 

menu to select Yes the user has or plans on obtaining a CITRIX AIM I/II account or 

No to signify the user does not have and is not planning on obtaining a CITRIX AIM 

I/II account. 

o Are you a stand-alone AIM user* - Drop-down menu to select Yes the user uses 

AIM I/II in a stand-alone environment or No to indicate the user does not use AIM 

I/II in a stand-alone environment. 

Mandatory fields are indicated by an Asterisk (*). 

Once all fields are filled-in click the Submit button to submit the account request. 

1.5.1 User Account Management and Privileges 

End-user privileges are managed by either a System Administrator or designated administrators 

at each Center. They will define user profiles with specific access levels. Privilege levels will 

also be assigned based on the role of the user. The following bullets provide application 

functionality regarding user administration. Users may have multiple sessions open in CPM, with 

the following restrictions: 

 All sessions must be from the same workstation. 

 All sessions must use the same Internet browser. 

User activity will be tracked and monitored periodically by the System Administrator. 

Users will be assigned Roles and Views within the CPM: 

 Roles: Yes/No 
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o CPM System Administrator: System administrators have the ability to change the 

owner of a content project and are able to delete projects entered by content users. 

o Center CPM Administrator: Center CPM administrators have the ability to change the 

owner of a content project assigned to the Center. 

o Supervisor 

 Views: View/No View/Administrate 

o Data 

o Skills 

o Reports 

 Views: View/No View/Edit/Administrate 

o Project 

o Leader 

CPM Privileges for each tab: 

Privileges for the Data, Skills, Projects, and Reports tabs 

o None – CPM users assigned “None” will not be able to access these tabs. 

o View – CPM users assigned “View” will only have view privileges for these tabs. 

o Edit – CPM users assigned “Edit” will be able to add and modify data in Data, Skills, 

Projects, and Report tabs that they are assigned to as a team member and delete 

projects where they are assigned as the “Owner” 

o Administrator - CPM users assigned “Administrator” will be able to add, modify, and 

delete data for all projects assigned to their Center. 

Privileges for the Admin Tab 

o System Administrator –have the ability to add, edit, delete any data cell in CPM. 

Should be reserved for the AIM/CPM Support Team both functional and technical 

experts. 

o Center Administrator –access is intended for Center CPM Administrators for 

accepting/rejecting CPM User Accounts for their Center only and modifying roles for 

their personnel. 

o None –access is for all CPM users that are not System/Center Administrators. This 

access allows them None, View, Editor, or Administrator privileges for the Data, 

Skills, Projects, Reports, and Admin Tab. 
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1.6 FORGOT YOUR PASSWORD? 

If you forget your password just click on ‘Forgot your password?’ below the password field. 

Refer to Figure 1-3. 

 

Figure 1-3. Forgot Password 

Enter the required information in the *fields provided and click on Submit. An Administrator 

will Email you and provide you with a password. 

1.7 HISTORY (DATA RETENTION) 

The History Icon   is used to view previous edits of selected data. To review the History of a 

giving data element, highlight the element and click the History Icon. This will display a list of 

modifications that have occurred since the element was created. The list is chronological from 

the bottom up, starting with the creation of the data element, see figure below. 

The History list can be used to revert the data element to a previous iteration of the data by 

highlighting the desired iteration and clicking the Revert Icon  . 

Data elements will only revert when the Element where they were created is reverted, for 

example reverting a Section will revert the information on the General tab for the Section but 

will not revert the Objective if one has been created. 
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Performance Requirements history can be reviewed using the History Icon, however they cannot 

be reverted. 

 

Figure 1-4. History List 
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2.0 HOME 

When you login to the Content Planning Module (CPM) the Home tab and menu items are 

enabled. From the Main menu item you can view projects you are creating or are a team member, 

assignments, messages sent and received by other system users, events, and system 

announcements. The Project Title area is an active field and when a Project Title is selected CPM 

will open the Project tab and Show the Details of the project. 

The Home menu items consist of: 

 Milestones – Create/Edit/Delete milestones 

 Messages – Create/Send, Print and Delete messages to/from registered CPM users 

 Assignments – Create/Edit/Delete Assignments 

 My Profile – Edit the Profile originally created when you registered for CPM 

 Change Password – Change your password to another password 

 

Figure 2-1  CPM Home 

2.1 MILESTONES 

The Milestones menu item is where you will create your events. 

The Milestones menu items consist of: 

  New icon – Create a new event 

  Delete icon – Delete an Event from the list 
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Figure 2-2  Milestones 

To create a new event: 

Step 1 From the Content Planning Module window select the Home tab.  

Step 2 Click on the Milestones menu item. 

Step 3 Click on the New icon. 

Step 4 Enter the desired information in the following fields: 

o Title 

o Location 

o Start Date 

o Start Time 

o End Date 

o End Time 

o Note 

Step 5 When complete click on the Save button. The event will appear in the list in the 

left hand pane by Event Title, Start Date and End Date. Once an Event has been 

added to the database, highlighting the Event in the left pane permits you to edit it 

in the right hand pane. Cancel will close the New Event pane and the event will 

not be added to the list in the left hand pane. 

To delete a milestone from the list: 

Step 1 From the Content Planning Module window select the Home tab.  
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Step 2 Click on the Milestones menu item. 

Step 3 Click on the Milestone you want to delete in the list.  

Step 4 Click on the Delete icon. 

Step 5 Click on OK when asked for confirmation to delete the event or Cancel to return 

to the folder without deleting the event. 

Milestones can be created from the Milestones submenu page but will not be assigned a Project, 

whereas Milestones developed in a Project will be assigned to that Project. Refer to Section 

6.2.3.8 Milestones for more information regarding adding, editing, or deleting Milestones. 

2.2 MESSAGES 

Clicking on the Messages menu item opens your message center. There are two folders in 

Messages, Inbox and Sent Items. The default is Inbox when you access the Messages. Messages 

in your Inbox are displayed on the Home Page by date and subject. To select the Sent Items 

folder click on the down arrow and click on Sent Items. When either folder is open a list of 

messages received or sent will be displayed by who the message was from, subject and the date it 

was received in the left hand pane. When the message is highlighted in the left pane, the text of 

the message can be read in the right pane. 

There are five icons associated with Messages: 

  New – Create a new message 

  Reply – Reply to a received message in your Inbox to the sender only. 

  Reply to All – Reply to a received message in your Inbox to all addressees. 

  Forward – Forward a highlighted message in you Inbox to other CPM users 

  Delete – Delete the highlighted message in your Inbox or Sent Items 

  Print– Print the highlighted message 
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Figure 2-3  Messages 

To create a new message: 

Step 1 From the Content Planning Module window select the Home tab to open the 

Homepage. 

Step 2 Click on the Messages menu item.  

Step 3 Click on the New icon. 

Step 4 Click the down arrow in the right hand pane “To” field and select the CPM user 

the message will be sent to from the list. 

Step 5 Click the down arrow in the right hand pane “Cc” field and select the CPM user 

the message will be copied to from the list if desired. 

Step 6 Type the subject of the message in the “Subject” field.  

Step 7 Type the content of the message in the Content field. 

Step 8 When the message is complete click on the Send button. The message will appear 

in the Sent Items folder. Cancel will close the New Message pane and the 

message will not be sent. 

To reply to a received message in your Inbox: 

Step 1 From the Content Planning Module window select the Home tab to open the 

Homepage. 

Step 2 Click on the Messages menu item. 

Step 3 Click on the message you want to reply to in the Inbox.  
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Step 4 Click on the Reply or the Reply to All icon. 

Step 5 Click the down arrow in the right hand pane “Cc” field and select the CPM user 

the message will be copied to from the list if desired. 

Step 6 Type the content of the message you want to add for the Reply in the Content 

field. 

Step 7 When complete click on the Send button. The message will appear in the Sent 

Items folder. Cancel will close the Message pane and the message will not be sent. 

 



Content Planning Module (CPM) User’s Manual  HOME 

Release 5.15  2-6 

To forward a message in you Inbox to other CPM users: 

Step 1 From the Content Planning Module window select the Home tab to open the 

Homepage. 

Step 2 Click on the Messages menu item. 

Step 3 Click on the message you want to forward in the Inbox.  

Step 4 Click on the Forward icon. 

Step 5 Click the down arrow in the right hand pane “To” field and select the CPM user 

the message will be forwarded to from the list. 

Step 6 Click the down arrow in the right hand pane “Cc” field and select the CPM user 

the message will be copied to from the list if desired. 

Step 7 Type additional content desired above the original message in the Content field.  

Step 8 When the Forward message is complete click on the Send button. The message 

will appear in the Sent Items folder. Cancel will close the Message pane and the 

message will not be sent. 

To delete a message from your Inbox or Sent Items folder: 

Step 1 From the Content Planning Module window select the Home tab to open the 

Homepage. 

Step 2 Click on the Messages menu item. 

Step 3 Click on the message you want to delete in either the Inbox or Sent Items folder.  

Step 4 Click on the Delete icon. 

Step 5 Click on OK when asked for confirmation to delete the message or Cancel to 

return to the folder without deleting the message. 

2.3 ASSIGNMENTS 

The Assignments menu is where you will create your personal assignments. 
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The Assignments menu items consist of: 

  New icon – Create a new Assignment 

  Delete icon – Delete an Assignment from the list 

  Print– Print the highlighted message 

 

Figure 2-4  Assignment Status 

To create a new Assignment: 

Step 1 From the Content Planning Module window select the Home.  

Step 2 Click on the Assignments menu item. 

Step 3 Click on the New icon. 

Step 4 Enter the desired information in the following fields: 

 Title 

 Start Date 

 Status 

o Not Started  

o In Progress  

o Completed  

o Waiting 

o Deferred 

 End Date 

 Priority 

o Low 

o Normal 
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o High 

 Note 

Step 5 When complete click on the Save button. The Assignment will appear in the list 

in the left hand pane by Title and on the Home Page by Start Date and Title. Once 

an Assignment has been added to the database, highlighting the Assignment in the 

left pane permits you to edit it in the right hand pane. Cancel will close the Task 

pane and the Assignment will not be added to the list in the left hand pane. 

To delete an Assignment from the list 

Step 1 From the Content Planning Module window select the Home tab to open the 

Homepage. 

Step 2 Click on the Assignments menu item. 

Step 3 Click on the Assignment you want to delete in the list.  

Step 4 Click on the Delete icon. 

Step 5 Click on OK when asked for confirmation to delete the Assignment or Cancel to 

return to the folder without deleting the Assignment. 

2.4 MY PROFILE 

My Profile information is the same account information provided to the System Administrator to 

obtain a login and password for the CPM software. You can update your account information to 

keep it current. The System Administrator populates the Registration Date, Access, User ID and 

drop-down menu items. 
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2.5 CHANGE PASSWORD 

The Change Password menu item provides a means to change your password in the database. 

 

Figure 2-5. Change Password 

Fill in the required fields and click on the save button to change your password. The following 

rules apply to password creation: 

1. At least 15 characters long. 

2. Contains a mix of upper case and lower case letters, numbers, and special characters (at 

least one of each). 

3. Users must not use personal information, such as names, phone numbers, account names, 

or dictionary words. 

4. Must be changed every 60 days. 

5. Cannot reuse any of the previous 10 passwords. 

6. Cannot change password more than once a day. 

Accounts will be automatically disabled after three unsuccessful login attempts and an email will 

be sent to the user and the System Administrator. 

The user email will contain information on how to re-activate their account.  

Accounts not accessed within 35 days will be automatically disabled. 

Accounts using CAC Authentication will not have the ability to change passwords. 
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3.0 DATA 

The Data tab provides an area where the Administrator can add and edit specific data in the 

database. 

When approved, this data is made available for use in other CPM tabs such as JDTA and 

Projects. 

 

Figure 3-1  Data Platforms 

The data provided by EDE consist of: 

 Platforms 

 Systems 

 Subsystem 

 Components 

 Non-Equipment 

 Environments 

 Tools 

 Resources 

 

Figure 3-2  Data Verbs 
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The data provided by the Integrated Learning Environment (ILE) specifications for development 

of learning objectives consists of: 

 Verbs 

 Conditions 

 Standards 

Conditions and Standards can be added by the Center Administrators. Additions or deletions to 

the verb list is controlled by NETC N74. If an item is used in a Curriculum Outline of Instruction 

it cannot be edited or deleted. 

The verbs cover the cognitive, affective and psychomotor domains. 

 

Figure 3.3 KSATRs 

Knowledge, Skill, Ability, Tool, and Resource (KSATR) items can be added to the Data tab by 

performing the following steps: 

1. Select the KSATR submenu item from the Data tab. 

2. Select the appropriate data item (Knowledge, Skill, Ability, Tool, or Resource) from the 

drop-down menu, see figure 3.3. 

3. Select the New Icon from the Menu bar, see Figure 3.4 below. 

 

Figure 3.4 
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4. Add the appropriate Text in the Title box, Type will be added based on the selection from 

the drop-down menu in Step 2. 

5. Click the Save button. 

To edit an existing KSATR perform the following steps: 

1. Select the KSATR submenu item from the Data tab. 

2. Select the appropriate data item (Knowledge, Skill, Ability, Tool, or Resource) from the 

drop-down menu, see figure 3.3. 

3. Highlight the desired KSATR. 

4. Click the Edit button in the right side pane. 

5. Make the desired changes. 

6. Click the Save button. 

Additionally, Related Materials can be added to the Resource by following these steps: 

1. Select the KSATR submenu item from the Data tab. 

2. Select Resource from the drop-down menu, see figure 3.3. 

3. Highlight the desired Resource. 

4. Click the Select Icon  . 

5. Enter desired Related Materials. 

6. Click the Save button. 

3.1 CENTER FILTERING 

Centers have the capability to filter any of the DATA sub-menu tabs to include only those items 

that pertain to the specific center. To filter on any of the sub-menu tabs complete the following 

steps: 

1. Select the desired DATA tab sub-menu tab (Platform, System, Subsystem, Components, 

Non-Equipment, Environments, Tools, Resources, Verbs, Conditions, Standards, or 

KSATRs). 

2. Click the Select icon (the blue circle with the white check mark). 

3. Click the Edit button. 

4. Select the desired items by clicking on the checkbox in the right-hand column. 

5. There is also a Search feature above the list of items that can be used to search for 

specific items. 

6. Once all items have been selected, click the Save button. 



 

 

 

(This Page Intentionally Left Blank) 



 

 

CHAPTER 4 OCCSTDS 

OCCSTDS (Occupational Standards)  

4.0 OCCSTD ........................................................................................... 4-1 
4.1 OCCSTDS RATING VIEWS .............. ERROR! BOOKMARK NOT 

DEFINED. 
4.2 NAVY TASK CLASSIFICATION ..... ERROR! BOOKMARK NOT 

DEFINED. 
4.3 REPORTS ........................ ERROR! BOOKMARK NOT DEFINED. 

 

 



 

 

 

(This Page Intentionally Left Blank) 



Content Planning Module (CPM) User’s Manual  OCCSTD 

Release 5.15  4-1 

 

4.0 OCCSTD 

The OCCSTDs tab displays the Occupational Standards and Naval Standards developed by 

NAVMAC. These standards occupationally define the work performed by enlisted personnel. 

NAVSTDs together with OCCSTDs form the basis for the Job, Duty, Task Analysis (JDTA) skills 

developed on the JDTA tab. 

• OCCSTDs (Occupational Standards) – Statements that describe the Navy’s minimum 

requirement/skills of a Navy enlisted rating as established by the rating’s primary 

(resource/warfare) sponsor. OCCSTDS state what enlisted personnel must do in their rate 

or rating and are minimum essential tasks and general responsibility levels. 

• NAVSTD (Naval Standards) – Standards that generally express the non-rating specific 

skill and knowledge requirements for enlisted personnel in paygrades E-1 through E-9 

(e.g., all E-6 personnel must know how to write enlisted performance evaluations). 

NAVSTD are stated in the form of skill or knowledge statements. 

The OCCSTDs tab has four main sections: By Learning Center, All Ratings, By Navy Task 

Classification, and Reports. The By Learning Center and All Ratings display OCCSTDs. The By 

Navy Classification section displays the OCCSTDs tasks in the Department of Labor O*NET 

classification structure. The Reports section allows you to create and run reports to output the 

OCCSTDs tasks. 

NOTE: Unless otherwise noted, the term Rating will be used to refer to Ratings, Service Ratings, 

Naval Standards (NAVSTDs), or Apprentice OCCSTDs 

4.1 OCCSTDS RATING VIEWS 

The left pane of the OCCSTDs By Learning Center screen contains a tree structure consisting of 

Centers. Each Center can be expanded to show the list of Ratings belonging to that Center as seen 

in Figure 4- 1 below. You can choose to the see the Latest version of the OCCSTDs, or All 

versions of the OCCSTDs, using the drop-down menu on the screen. 
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Figure 4- 1 OCCSTD By Learning Center 

The left pane of the OCCSTDs All Ratings screen lists all Ratings in alphabetical order as seen in 

Figure 4-2 below. OCCSTDs tasks can be viewed in three different ways. 

• Expanding the Tasks (Core Only) folder will list all task, grouped by paygrade and then 

listed alphabetically. 

• Expanding the Functional Areas folder will list all functional areas for the Rating. 

Expanding a Functional Area will then list all tasks for the functional area, grouped by 

paygrade and then alphabetically. 

• Expanding the Jobs folder will list all jobs for the Rating. Expanding a Job will then list 

all Functional Areas for that job, and then expanding a Functional Area will then list all 

tasks for the functional area, grouped by paygrade and then alphabetically.. 
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Figure 4- 2 OCCSTDs All Ratings 

4.1.1 Creating a New Rating 

A new Rating can only be created on the By Learning Center screen. To create a new Rating: 

Step 1. Click on the Learning Center that the Rating belongs to. 

Step 2. Click on the  New icon.  

Step 3. Select the Type of Rating from the Type drop-down. 

Step 4. Enter the Title of the new Rating. 

Step 5. Enter the Career Field. 



Content Planning Module (CPM) User’s Manual  OCCSTD 

Release 5.15  4-0 

 

 

Step 6. Enter the Publication Date of the Rating.  

Step 7. Enter the Scope of Rating text. 

Step 8. Click the Save button to save the new Rating, or click the Save & Add button 

to add another Rating and save the new Rating. 

 

Figure 4- 3 New Rating Input Screen 

To Delete a Rating 

Click on the Rating to delete, and click the Delete icon. CPM will not allow you to delete a 

Rating that has been selected as the basis of a JDTA skill. 

To Edit a Rating 

Click on the Rating to edit, and click the Edit button. Make the desired changes, then click the 

Save button. 
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To Print a List of All Ratings 

On the By Learning Center screen, click on the  Print icon. CPM will create a PDF file that 

lists all the Ratings available under each Learning Center 

4.1.2 Importing Rating Information 

Step 1. Click on the Rating. 

Step 2. Click on the  Import icon. 

Step 3. Click the Browse… button to select the 'frmEditSelectPayPlanCat.xlsx' or 

'frmEditSelectPayPlanCat.csv' file. 

Step 4. Click the Browse button to select the Task File for the Rating/Service Rating. 

Step 5. Click the Upload button. 

Step 6. Click the OK button to close the “OCCSTDs file imported successfully!” 

message. 

To Create a New Version of a Rating 

Click on the Rating to update, then follow the steps above on Importing Rating 

Information (4.1.2). A new version of the Rating is created once the import is complete. 

You may wish to update the Scope of Rating and the Publication Date to the latest 

information for that Rating. 

4.1.3 Exporting OCCSTDs Information 

OCCSTDs data can be exported from the By Learning Center, All Ratings, and By Navy Task 

Classification screens in a Microsoft Excel.xlsx format. 

Step 1. Click on the  Export icon. 

Step 2. Make the desired selections on what to export on the Criteria tab. 

• Report Type drop-down 

o Select OCCSTD to export OCCSTDs as they are shown in the By 

Learning Center or All Ratings screens 

o Select NTC to export OCCSTDs as they are shown on the By Navy Task 

Classification screen. 

• Type drop-down options depend on the Report Type selection 

o OCCSTD Report Type 
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 Latest-OCCSTDs will export the latest version of the 

OCCSTDs tasks 

 All-OCCSTDs will export all versions of the OCCSTDs tasks 

 NTC Codes Not Assigned will export all OCCSTDs tasks that do 

not have Navy Task Classification codes assigned to them 

o NTC Report Type 

 Used-NTC will export the Navy Task Classification codes that 

have been assigned to OCCSTDs tasks 

 All-NTC will export all Navy Task Classification codes 

• Flagged Tasks Only checkbox, when checked the export will only 

include the OCCSTDs tasks that are new in the latest version of a 

Rating. Note: Version 1 tasks do not get flagged. 

• Click on the blue text to select what to export. The fields will prefill 

depending on what is selected in the tree structure, that selection can be 

changed as desired. A selection does not have to be made in any of 

these fields. Any selection made does not limit the selection in any of 

the other fields. For example, selecting a Rating does not limit the 

options under the Functional Area or Job fields. 

o Rating 

o Paygrade 

o Functional Area 

o Job 

o Major (from Navy Task Classification) 

o Minor (from Navy Task Classification) 

o Group (from Navy Task Classification) 

NOTE: CPM will create an export of all OCCSTDs data that matches the selected criteria 
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Figure 4-4 Export Criteria 

Step 3. Click on the Options tab to select how the OCCSTDs information will 

be exported. 

• Order By drop-down options depend on the Report Type selection on the 

Criteria tab. 

o OCCSTD Report Type 

 Job – data will be grouped by Job (i.e. as seen in the All Ratings 

screen), with the Functional Areas listed alphabetically within 

each Job, and tasks will be ordered by paygrade then 

alphabetically within each Functional Area. 

 Functional Area – data will be grouped by Functional Area (i.e. as 

seen in the All Ratings screen), with tasks ordered by paygrade then 

alphabetically within each Functional Area. 

 Task– data will not be grouped, instead it will list all tasks that 

match the export criteria, ordered by paygrade then alphabetically. 
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o NTC Report Type –data will be grouped by task classification (i.e. 

as seen in the By Task Classification screen) 

• One Rating per Sheet checkbox, when multiple Ratings are exported at 

one time, checking this checkbox will export each Rating to a separate 

Worksheet in the MS Excel output and the tab for each Worksheet will 

show the Career Field and Publication Date of the Rating. 

• Include Job Information checkbox, when checked, this adds an additional 

Worksheet to the MS Excel output that will list the data on the job 

information screen under the Job and DOD/O*NET tabs for all jobs that are 

found by the Criteria. So, if a Rating is selected as a criterion, then the Job 

Worksheet will list the job information for all the jobs that make up the 

rating. 

Step 4. Select which columns will be exported by selecting/unselecting the 

appropriate checkbox. 

Step 5. Click on the  Resequence button to reorder the columns as desired. 

Step 6. Click on the Run Report button to create the export file. Once the export is 

complete, the Export Criteria/Options screen will show with the export 

settings used, so you can make changes and click Run Report again to fine-

tune the output. 

Step 7. Click on the Save a Copy As… button to save the export settings as a report (see 

4.3 for more detail on reports). A new window will open. 

• Title – enter the name for the report. 

• Center – this defaults to your center. If you have access to multiple 

centers, select the applicable center for the report. 

• Owner – this defaults to the current user name. 

• Public checkbox, when the checkbox is checked, the report will be 

listed under the selected Center for anyone to run. 

• Click on the Save button to save the report. Click on the OK button to 

close the message that the report saved successfully. 



Content Planning Module (CPM) User’s Manual  OCCSTD 

Release 5.15  4-5 

 

Figure 4- 5 Export Options 

4.2 NAVY TASK CLASSIFICATIONS 

The Navy Task Classification (NTC) classifies OCCSTDs tasks within a standard taxonomy 

that uses Major, Minor, and Functional Group Codes based on the U.S. Department of Labor 

Standard Occupational Classification system. The NTC Code is composed of a Major Group 

Code, a Minor Group Code, and a Functional Group Code. 

The left pane of the OCCSTDs By Navy Task Classification screen contains a tree structure 

consisting of Major Codes. Expanding a Major Group displays the Minor Groups that belong 

to the Major Group, and expanding a Minor Group displays the Functional Groups that 

belong to the Minor Group. Expanding a Functional Group displays all the OCCSTDs tasks 

assigned to that NTC Code. Tasks are ordered by paygrade then alphabetically, with the 

Career Field appended to each task, as seen in Figure 4-6 below. 

You can choose to the see Navy Task Classification (NTC) Codes that are Used by OCCSTDs 

tasks, or All NTC Codes, or view those Ratings that have NTC Codes Not Assigned yet 

using the drop-down menu on the screen. 
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Figure 4-6 OCCSTDs By Learning Center 

4.2.1 Importing NTC Information 

Step 1. Click on the  Import icon. 

Step 2. Click the Browse… button to select the NTC Code MS Excel file, which must 

be in .xlsx format. 

Step 3. Click the Upload button. 

Step 4. Click the OK button to close the “NTC file imported successfully!” message. 

4.2.2 Exporting OCCSTDs Tasks with No NTC Codes 

Step 1. On the By Navy Task Classification screen, select NTC Codes Not Assigned 

to view the Ratings to export. 

Step 2. Click on the  Export icon 

Step 3. Select OCCSTD from the Report Type drop-down. 

Step 4. Select NTC Codes Not Assigned from the Type drop-down. 
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Step 5. If desired, click on Rating to limit the number of Ratings in the export to the 

ones displayed on the screen. 

Step 6. Click on the Options tab to select how the OCCSTDs information will 

be exported. 

Step 7. Select which Order By option is desired from the drop-down. 

• Job – data will be grouped by Job (i.e. as seen in the All Ratings screen), 

with the Functional Areas listed alphabetically within each Job, and tasks 

will be ordered by paygrade then alphabetically within each Functional 

Area. 

• Functional Area – data will be grouped by Functional Area (i.e. as seen 

in the All Ratings screen), with tasks ordered by paygrade then 

alphabetically within each Functional Area. 

• Task– data will not be grouped, instead it will list all tasks that match 

the export criteria, ordered by paygrade then alphabetically. 

Step 8. If desired, check the One Rating per Sheet checkbox, when exporting multiple 

Ratings are at one time. 

Step 9. Click on the Run Report button to create the export file. 

Step 10. Click on the Save a Copy As… button to save the export settings as a report (see 

4.3 for more detail on reports). A new window will open. 

• Title – enter the name for the report. 

• Center – this defaults to your center. If you have access to multiple 

centers, select the applicable center for the report. 

• Owner – this defaults to the current user name. 

• Public checkbox, when the checkbox is checked, the report will be 

listed under the selected Center for anyone to run. 

• Click on the Save button to save the report. Click on the OK button to 

close the message that the Standards Report saved. 

4.3 REPORTS 

Reports save export criteria and settings. This means you can set up the export settings and 

save those, without setting any export criteria. Then, when you need to export OCCSTDs 

information, you choose the criteria for that particular export, knowing that the settings will 

create an MS Excel spreadsheet with just the information that you need. 

The left pane of the OCCSTDs Reports screen lists the reports that are available. You can 
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choose to the see all Reports that are Public, those that you created or made a Favorite under My 

Reports, or Public Reports by Center, using the drop-down menu on the screen, as seen in Figure 

4-7 below. 

 

Figure 4-7 Reports Menu 

When you have created a report/export settings that other users at your command also want to 

run, then you can check the Public box. A Public report can be run by anyone, and users can 

make changes to the criteria or options when they run the report. Users can save a copy of the 

Public report/export settings that they modified for their needs. Only the owner of the report or 

the center’s CPM manager can make and save changes to a Public report/export settings. Users 

can mark Public reports as Favorites for easy access under the My Reports view. 

4.3.1 Creating a New Report 

Step 1. Select My Reports from the drop-down on the Reports screen.  

Step 2. Click on the  New icon. 

Step 3. Enter the Report Title. 
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Step 4. If you belong to more than one center, select the Center* this report belongs 

to from the drop-down list. 

Step 5. Check the Public checkbox, if other user should be able to run the report. 

Step 6. If you are a CPM Manager, select the Owner of the report from the drop-

down list. 

 

Figure 4-8 Reports Main Tab 

Step 7. Click on the Criteria tab to make the selections on what to export. 

• Report Type drop-down 

o Select OCCSTD to export OCCSTDs as they are shown in the By 

Learning Center or All Ratings screens 

o Select NTC to export OCCSTDs as they are shown on the By Navy Task 

Classification screen. 

• Type drop-down options depend on the Report Type selection 

o OCCSTD Report Type 

 Latest-OCCSTDs will export the latest version of the 

OCCSTDs tasks 

 All-OCCSTDs will export all versions of the OCCSTDs tasks 

 NTC Codes Not Assigned will export all OCCSTDs tasks that do 

not have Navy Task Classification codes assigned to them 

o NTC Report Type 
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 Used-NTC will export the Navy Task Classification codes that 

have been assigned to OCCSTDs tasks 

 All-NTC will export all Navy Task Classification codes 

• Flagged Tasks Only checkbox, when checked the export will only 

include the OCCSTDs tasks that are new in the latest version of a 

Rating. Note: Version 1 tasks do not get flagged. 

• Click on the blue text to select what to export. The fields will prefill 

depending on what is selected in the tree structure, that selection can be 

changed as desired. A selection does not have to be made in any of 

these fields. Any selection made does not limit the selection in any of 

the other fields. For example, selecting a Rating does not limit the 

options under the Functional Area or Job fields. 

o Rating 

o Paygrade 

o Functional Area 

o Job 

o Major (from Navy Task Classification) o Minor (from Navy Task 

Classification) o Group (from Navy Task Classification) 

NOTE: CPM will create an export of all OCCSTDs data that matches the selected criteria. 
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Figure 4-9 Report Criteria Tab 

Step 8. Click on the Options tab to select how the OCCSTDs information will 

be exported. 

• Order By drop-down options depend on the Report Type selection on the 

Criteria tab. 

o OCCSTD Report Type 

 Job – data will be grouped by Job (i.e. as seen in the All Ratings 

screen), with the Functional Areas listed alphabetically within 

each Job, and tasks will be ordered by paygrade then 

alphabetically within each Functional Area. 

 Functional Area – data will be grouped by Functional Area (i.e. as 

seen in the All Ratings screen), with tasks ordered by paygrade then 

alphabetically within each Functional Area. 
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 Task– data will not be grouped, instead it will list all tasks that 

match the export criteria, ordered by paygrade then alphabetically. 

o NTC Report Type –data will be grouped by task classification (i.e. 

as seen in the By Task Classification screen) 

• One Rating per Sheet checkbox, when multiple Ratings are exported at 

one time, checking this checkbox will export each Rating to a separate 

Worksheet in the MS Excel output and the tab for each Worksheet will 

show the Career Field and Publication Date of the Rating. 

• Include Job Information checkbox, when checked, this adds an additional 

Worksheet to the MS Excel output that will list the data on the job 

information screen under the Job and DOD/O*NET tabs for all jobs that are 

found by the Criteria. So, if a Rating is selected as a criterion, then the Job 

Worksheet will list the job information for all the jobs that make up the 

rating. 

Step 9. Select which columns will be exported by selecting/unselecting the 

appropriate checkbox. 

Step 10. Click on the  Resequence button to reorder the columns as desired. 

Step 11. Click on the Run Report button to create the export file. Once the export is 

complete, the Export Criteria/Options screen will show with the export 

settings used, so you can make changes and click Run Report again to fine-

tune the output. 

Step 12. Click on the Save a Copy As… button to save the export settings as a report (see 

4.3 for more detail on reports). A new window will open. 

• Title – enter the name for the report. 

• Center – this defaults to your center. If you have access to multiple 

centers, select the applicable center for the report. 

• Owner – this defaults to the current user name. 

• Public checkbox, when the checkbox is checked, the report will be 

listed under the selected Center for anyone to run. 

• Click on the Save button to save the report. Click on the OK button to 

close the message that the report saved successfully. 
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Figure 4-10 Report Option Tab 

To Delete a Report 

Select the report to delete, and click the Delete icon. Click on the OK button to delete 

the report. 

To Run a Report – Without Making Changes 

Select the report to run, then click on the  Export icon. This will create a spreadsheet 

based on the criteria and options set for that report. 

To Run a Report – With Changes 

If you want to make changes prior to running the report (e.g. selecting a specific Rating to 

export), select the report, then click on the Edit button. This allows you to make changes and 

run the report, without saving the report. If you want to save the changes you made to a Public 

report, click on the Save a Copy As button to save the Report under My Reports. 

To View the History of a Report 

Select the report, then click on the  History icon. This lists the history of the report. 
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4.3.2 Working with Favorite Reports 

You can mark a Public report as a Favorite. Marking a report as a Favorite places it in your 

list of reports when you select the My Reports view. 

To Add a Report to Your Favorites/My Reports 

Select any public report, then click on the  Favorite icon. The report is now available on 

the My Reports view. Any favorite report title will be Bold to help you distinguish between 

your reports and your favorite reports. 

To Remove a Report from Your Favorites/My Reports 

Select the favorite report, then click on the  Delete icon. This will remove the report 

from your My Reports view. 

 



 

 

 

(This Page Intentionally Left Blank) 



 

 

CHAPTER 5 JDTA 

JDTA 

5.0 JDTA .................................................................................................. 5-1 
5.1 OCCUPATION .................................................................................. 5-5 

5.2 JOB .................................................................................................... 5-5 
5.3 DUTY ................................................................................................ 5-6 
5.4 TASK, SUBTASK, STEP .................................................................. 5-7 

5.5 ADDING A NEW OCCUPATION, JOB, DUTY, TASK, SUBTASK, 

OR STEP: ........................................................................................ 5-11 
5.6 TO CREATE A NEW VERSION OF AN APPROVED JOB, DUTY, 

TASK, SUBTASK, OR STEP: ........................................................ 5-21 
5.7 COPY AND PASTE JDTA ELEMENTS ....................................... 5-22 
5.8 IMPORTING CTTL DATA ............................................................ 5-23 

5.9 CENTER FILTERING .................................................................... 5-23 

5.10 JDTA SEARCH ............................................................................... 5-24 

5.11 IMPORTING FROM EXCEL SPREADSHEET ............................ 5-25 

 

 



 

 

 

(This Page Intentionally Left Blank) 



Content Planning Module (CPM) User’s Manual  JDTA 

Release 5.15  5-1 

5.0 JDTA 

The purpose of the Naval Education and Training Command's (NETC) Job Duty Task Analysis 

(JDTA) process is to establish a repeatable and defendable job analysis process to support 

content development or revision in order to satisfy fleet training requirements. 

At a minimum, the JDTA Process is designed to achieve the following goals: 

 Provide a standard process for capturing all pertinent data to describe work performed in 

the fleet. 

 Decompose and structure work. 

 Apply appropriate attributes to the work, at the task level, to more comprehensively 

describe the work. 

NOTE: 

Before using the JDTA tab, be sure to read the NETC 

policy (NAVEDTRA 137) for conducting JDTA. 

The JDTA tab contains the validated and approved data from the EDE. You can view your 

Center’s data to plan the content of your project.  

The JDTA items are identified by: 

 Center - A center is a major training command, such as the Center for Information 

Dominance. 

 Occupation - An occupation is a family of jobs that share a common set of skills. A job 

family includes all jobs at various skill levels in a particular field of work. In the Navy, an 

occupation can be associated with a rating and is comprised of one or more jobs. 

 Job - A job is comprised of duties and tasks. A job is composed of the duties, tasks, sub-

tasks, and steps performed by an individual that constitute their job. A job is comprised of 

one or more duties and it may be associate with the appropriate NEC or watch station. 

 Duty - A duty is a set of related tasks within a given job. A duty is a major part of a job. 

A duty is comprised of one or more tasks, it occurs frequently, and occupies a significant 

amount of time. 

 Task - A task is a single unit of specific work behavior, with clear beginning and ending 

points. It is directly observable and measurable. Tasks are a major part of a duty and may 

be comprised of one or more sub-tasks. A task is comprised of logical and distinct 

actions. A task is performed under a defined set of conditions and standards. Each task is 

independent of other tasks. 

 Subtask - A sub-task is a major part of a task. A sub-task may be made up of a series of 

steps performed under the standards and conditions of a task. A sub-task has a logical 

relationship with a task, duty, job, occupation. A sub-task may be comprised of one or 

more steps and fills a portion of the immediate purpose within a task. 



Content Planning Module (CPM) User’s Manual  JDTA 

Release 5.15  5-2 

 Step - A step is a major part of a sub-task. A step is the most specific form of behavior, 

and is the smallest component defined in the process. 

Each level of the JDTA may be resequenced using the resequence icon  . By default items are 

displayed alphabetically. 

The status of each JDTA element can be identified as follows: 

• Red - Incomplete 

• Yellow - Complete (ready for submission) 

• Purple - Submitted or Accepted 

• Green - Approved 

• Yellow with Red border - Rejected 

 

Status colors 

To view the JDTA items identified for your center perform the following:  

Step 1 From the CPM Homepage click on the JDTA tab. 

The Centers   are identified in the left hand margin. You can select to view All, 

Approved, Accepted, Submitted, New, or Rejected data for a Center by clicking the 

down arrow in the title bar. Refer to Figure 5-1. 
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Figure 5-1  CPM JDTA TAB 

Step 2 Highlight the desired center and explore the Occupations, Jobs, Duties, Tasks, 

Subtasks, and Steps identified for the center. 
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Figure 5-2  CENTER DATA  

To select the contents of the Center: 

Step 1 Highlight the desired center, click on the ‘+’ block next to the center and all the 

Occupations identified for the center will open. 

Step 2 Click on the ‘+’ block next to the Occupation to open the Jobs of the desired 

Occupation. 

Step 3 Click on the ‘+’ block next to the Job sub-folder to open the Duties for the Job 
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selected. 

Step 4 Click on the ‘+’ block next to the Duty sub-folder to open the Tasks for the 

Job selected. 

Step 5 Click on the ‘+’ block next to the Task sub-folder to open the Subtasks and for 

the Task selected. 

Step 6 Click on the ‘+’ block next to the Subtask sub-folder to open the Steps for the 

Subtask selected. 

Step 7 Click on the Step sub-folder to view the Steps of the Subtask selected. 

5.1 OCCUPATION 

The Occupation Tab is displayed in the right-hand pane when the Occupation is highlighted in 

the Left-hand pane. The elements of the Occupation Tab are: 

 Name: The name of the occupation, this field is required. 

 Version: The current version of the occupation, currently not editable. 

 Status: Current status of the occupation, currently not editable. 

 Type: JDTA type, currently not editable, should be Occupation.  

There are no other tabs for a JDTA Occupation. 

5.2 JOB 

The Job Tab is displayed in the right-hand pane when the Job is highlighted in the left-hand pane. 

There are two tabs associated with JDTA Jobs; the Job tab and the Job Attributes tab. The 

elements of the Job tab are: 

 Name: The name of the job, this field is required. 

 Version: The current version of the job, currently not editable. 

 Status: Current status of the job, currently not editable. 

 Type: JDTA type, currently not editable, should be Job. 

To access the Job Attributes tab click on the tab in the right-hand pane. The elements of the Job 

Attributes tab are: 

 Mission: The purpose of the job, this field is editable. 

 Description: A detailed description of the job, this field is editable. 
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 Rates: Navy Rates that the job applies to, this field is editable. 

 NEC: Navy Enlisted Classifications (NECs) that apply to the job, this field is editable. 

 DOL/ONET Occupation: Department of Labor O*NET occupations can be entered 

here, access to O*NET can be accomplished by clicking on the blue hyperlink below this 

field, this field is editable. 

NOTE: 

None of the elements of the Job Attributes tab are required. 

5.3 DUTY 

The Duty tab is displayed in the right-hand pane when the Duty is highlighted in the left-hand 

pane. There are three tabs associated with the JDTA Duties; the Duty, Existing Interventions, and 

KSATRs tabs. The elements of the Duty tab are: 

 Name: The name of the duty, this field is required. 

 Version: The current version of the duty, currently not editable. 

 Status: Current status of the duty, currently not editable. 

 Type: JDTA type, currently not editable, should be Duty. 

To access the Existing Interventions tab click on the tab in the right-hand pane. The elements of 

the Existing Interventions tab are Type and Intervention. To enter a new Existing Intervention 

perform the following steps: 

Step 1 Click on the New icon  .  

Step 2 Click on the Type dropdown. 

Step 3 Select the type of Existing Intervention from the dropdown menu.  

Step 4 In the Intervention text-box add appropriate text. 

Step 5 If a URL for the existing intervention exists it can be added by typing it in the 

Item URL: text box. Additionally, after the URL has been entered it can be 

launched by clicking on the Launch button. 

NOTE: 

While Existing Interventions are not required, if an Existing 

Intervention is added then Type and Intervention are required, Item 

URL is optional. 

To access the KSATRs tab click on the tab in the right-hand pane. The elements of the KSATRs 

tab are Type and Text. To enter a KSATR perform the following steps: 
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Step 1 Click on the Select icon  . 

Step 2 Click on the Type dropdown. 

Step 3 Select the type of KSATR from the dropdown menu.  

Step 4 Check all KSATRs that apply. 

NOTE: 

If the desired KSATR is not listed, click on the Filtering icon   

to see a complete list. If the desired KSATR is still not listed click 

on the New icon  to add a new KSATR. 

Step 5 Once all KSATRs of the selected type are selected, click the OK button.  

Step 6 Repeat this process as needed through all KSATR types. 

Duties may also be developed from existing OCCSTD data, to access the OCCSTD data perform 

the following steps: 

Step 1. Select the appropriate Duty in the left pane of the JDTA tab. 

Step 2. Click the Create From Icon  , which is different than the New Icon  .  

Step 3. From the right pane select the appropriate OCCSTD items to be used. 

Step 4. Click the Save button. 

Step 5. The items will populate the selected JDTA Duty. 

5.4 TASK, SUBTASK, STEP 

The Task, Subtask, and Step screens have the same tabs with the exception of the TTA, which is 

only available on the Task screen. The Task, Subtask, or Step tab is displayed in the right-hand 

pane when the Task is highlighted in the left-hand pane. The tabs associated with the JDTA 

Task, Subtask, and Step are; Task, Subtask, or Step, Task Attributes, TTA (Training Task 

Analysis), Existing Interventions, and KSATRs. The elements of the main tab are: 

 Verb: This is a dropdown to select the type of verb. Selections include; Verb, Verb- 

Cognitive, Verb-Psychomotor, or Verb-Affective. The selection from this dropdown 

determines which verbs will populate the (Select Item) dropdown. 

 Select Item:  Based on the selection from the Verb dropdown menu, a list of either all 

approved verbs or just Cognitive, Psychomotor, or Affective. 

 Text: This is the description of the task. 

 Version: The current version of the task, currently not editable. 
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 Status: Current status of the task, currently not editable. 

 Type: JDTA type, currently not editable, should be Task. 

 Task Level: Dropdown menu to select the level the task will be performed. The options 

are; Organizational, Intermediate, Depot, or N/A. 

 Status of Training: Dropdown menu indicating what the current status of training is 

associated with the task. Options are; Currently Being Training, Not Being Trained, Not 

fully supported through current training. 

 Type of Training: Hyperlink to a checklist of different types of training. Options are; 

Formal, PQS, JQR, RTM, OJT, and Other. 

NOTE: 

All required items are identified by an asterisk (*). 

To access the Task Attributes tab, click on the tab in the right-hand pane. The elements of the 

Task Attributes tab are: 

 Select Type: This is a dropdown to select the type of data to use. The options are; 

Platform, System, Subsystem, Component, or Non-Equipment. More than one Type may 

be selected. 

 Select Item: After the selection is made in the Select Type dropdown menu, the specific 

item can be selected from Select Item dropdown menu. By default this dropdown is 

filtered on center specific items, if the desired item is not show filtering can be turned off 

by selecting (Show All), then clicking on the dropdown triangle a second time. 

 Condition: Clicking on the blue hyperlink will display a list of Conditions. One or more 

Conditions can be selected. By default Conditions are filtered by center, if the desired 

Condition is not seen initially, click on the Filtering icon  , this will turn filtering off 

and a complete list of Conditions will be displayed. If the desired Condition is still not 

seen, click on the New icon  to create a new Condition. The Condition screen 

also has a search feature when a keyword can be entered and any Condition containing 

the keyword will be listed. 

 Standard: Clicking on the blue hyperlink will display a list of Standards. One or more 

Standards can be selected. By default Standards are filtered by center, if the desired 

Standard is not seen initially, click on the Filtering icon  , this will turn filtering off and 

a complete list of Standards will be displayed. If the desired Standards is still not seen, 

click on the New icon   to create a new Standard. The Standard screen also has a 

search feature when a keyword can be entered and any Standard containing the keyword 

will be listed. 

 Source: Clicking on the blue hyperlink will display a list of Sources. One or more 

Sources can be selected. By default Sources are filtered by center, if the desired Source is 

not seen initially, click on the Filtering icon  , this will turn filtering off and a complete 

list of Source will be displayed. If the desired Source is still not seen, click on the New 
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icon  to create a new Source. The Source screen also has a search feature when a 

keyword can be entered and any Source containing the keyword will be listed. 

NOTE: 

All fields of the Task Attributes tab are required. 

To access the Training Task Analysis (TTA) tab, click on the tab in the right-hand pane. The 

elements of the Training Task Analysis are: 

 Safety Hazard Severity (Select List Item) 

o Minor - Failure does not cause injury, property damage, or system damage but will 

result in unscheduled maintenance or repair. 

o Marginal - Failure may cause minor injury, minor property damage, or minor system 

damage, and will result in delay, loss of availability, or mission degradation. 

o Critical - Failure may cause severe injury, major property damage, or major system 

damage and will result in mission loss. 

o Catastrophic - Failure may cause death, property destruction, or system loss (e.g., 

aircraft, tank, missile, ship, etc.) 

 Criticality of Performance (Select List Item) 

o Minor - Inadequate performance does not result in injury to personnel or damage to 

equipment. 

o Marginal - Inadequate performance results in non-serious personnel injury or damage 

to equipment. 

o Critical - Inadequate performance results in serious or life threatening injury to 

personnel, or impedes the ability to perform a mission. 

o Catastrophic - Inadequate performance results in death or inability to carry out aq 

mission. 

 Task Delay Tolerance (Select List Item) 

o Low Delay Tolerance 

o High Delay Tolerance 

 Frequency of Performance(Select List Item) 

o At least annually 

o At least once every 6 months 

o At least monthly, but less than twice per week 

o Twice per week or more 

 Probability of Inadequate Performance (Select List Item) 

o Never performed correctly 
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o Less often than other tasks 

o About as often as other tasks 

o More often than other tasks 

 Difficulty of Performance (Select List Item) 

o No training required 

o Task requires 1 to 3 days to learn 

o Task may be learned in 1 to 2 weeks 

o Task may require up to 1 month or more to learn 

 Task Learning Difficulty (Select List Item) 

o No training required 

o Task requires 1 to 3 days to learn 

o Task may be learned in 1 to 2 weeks 

o Task may require up to 1 month or more to learn 

 Percent Performing (Select List Item) 

o 0 to 24% of personnel perform this task 

o 25 to 49% of personnel performance this task 

o 50 to 74% of personnel performance this task 

o 75 to 100% of personnel performance this task 

 Percent of Time Spent on Performance (Select List Item) 

o Task is not performed 

o Less time spent on this task than most other tasks 

o Same amount of time spent on this task as most others 

o ore time spent on this task than most others 

 Immediacy of Performance (Select List Item) 

o Task first performed within 2 to 4 years after assignment  

o Task first performed within 1 to 2 years after assignment  

o Task first performed within 6 months after assignment 

o Task performed during first 3 months after assignment 

To access the Existing Interventions tab click on the tab in the right-hand pane. The elements of 

the Existing Interventions tab are Type and Intervention. To enter a new Existing Intervention 

perform the following steps: 

Step 1 Click on the New icon  .  



Content Planning Module (CPM) User’s Manual  JDTA 

Release 5.15  5-11 

Step 2 Click on the Type dropdown. 

Step 3 Select the type of Existing Intervention from the dropdown menu.  

Step 4 In the Intervention text-box add appropriate text. 

Step 5 If a URL for the existing intervention exists it can be added by typing it in the 

Item URL: text box. Additionally, after the URL has been entered it can be 

launched by clicking on the Launch  

NOTE: 

While Existing Interventions are not required, if an Existing 

Intervention is added then Type and Intervention are required, Item 

URL is optional. 

To access the KSATRs tab click on the tab in the right-hand pane. The elements of the KSATRs 

tab are Type and Text. To enter a KSATR perform the following steps: 

Step 1 Click on the Select icon  .  

Step 2 Click on the Type dropdown. 

Step 3 Select the type of KSATR from the dropdown menu. 

Step 4 Check all KSATRs that apply. 

NOTE: 

If the desired KSATR is not listed, click on the Filtering icon   to 

see a complete list. If the desired KSATR is still not listed click on 

the New icon  to add a new KSATR. 

Step 5 Once all KSATRs of the selected type are selected, click the OK button.  

Step 6 Repeat this process as needed through all KSATR types. 

5.5 ADDING A NEW OCCUPATION, JOB, DUTY, TASK, SUBTASK, 

OR STEP: 

Step 1 Highlight the desired center, click on the ‘+’ block next to the center and all the 

Occupations identified for the center will open. 

Step 2 Highlight the appropriate folder to add the new item as follows: 

a. Center to add a Occupation  

b. Occupation to add a Job 

c. Job to add a Duty  

d. Duty to add a Task 
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e. Tasks to add a Subtask  

f. Subtask to add Step 

Step 3 Click on the New  icon. To add another item at the same level use the "Save 

and Add" button. 

Step 4 In the right hand pane enter the applicable information in the following fields: 

a. For a New Occupation: 

 

Figure 5-5  OCCUPATION TAB 

 Enter the Name of the Occupation in the Skill tab and click on the Save 

button. 

 Click on the Show Privileges   icon and identify the personnel that will 

Approve, View, Edit, or Review the JDTA items for the Occupation. Save 

your selections, by clicking on the Save button, when completed. 
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Figure 5-6 SELECTING PRIVILEGE for an OCCUPATION 

b. For a New Job: 

 Enter the Name of the Job in the Skill tab and click on the Save button. 

 Enter the applicable information in the Job tab which contains text fields for 

Mission, Description, Rate, NEC, and DOL/ONET Occupation. Save your 

entries. 

 

Figure 5-7 JOB TAB for a JOB 

 Click on the Job title in the left pane. Click on the Submit button in the right 

hand pane to submit your new Job for Approval when completed. Note that 

the status of an item will change from New to Submitted. Other status 

indicators are Approved, Accepted, and Rejected. After it has been submitted, 

new buttons will appear in the left hand screen for Accepted and Rejected. 

Once Accepted a button will appear for Approved. 

c. For a New Duty: 

 Enter the Name of the Duty in the Skill tab and click on the Save button. 
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 Enter information in the Existing Interventions tab by clicking on the New  

icon, select the type from the drop down menu and identify the Intervention in 

the field provided. Save your entries when completed. 

 To add KSATRs for a new Duty perform the following steps: 

i.   Click on the KSATRs tab.  

ii.  Click the Edit button. 

iii. Click on the Select   icon. 

iv.  Select the desired KSATRs for each type by first selecting the type 

from the Type drop-down menu, then checking the desired KSATR 

from the list provided.(Note: By default only KSATRs for the current 

site are displayed, if the desired KSATR is not shown click the Filter  

 icon. This will display all KSATRs of a given type.) 

 

Figure 5-8 KSATRs TAB for a DUTY 

 Click on the Duty title in the left pane. Click on the Submit button in the right 

hand pane to submit your new Duty for Approval when completed. Note that 

the status of an item will change from New to Submitted. Other status 

indicators are Approved, Accepted, and Rejected. After it has been submitted, 

new buttons will appear in the left hand screen for Accepted and Rejected. 

Once Accepted a button will appear for Approved 
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d. For a New Task: 

Figure 5-9 TASK TABS 

 In the Task Tab: 

(1) Select the appropriate verb for the task from the drop-down list.  

(2) Enter the text of the Task in the Text field. 

(3) Using the drop-down menu select the Task Level as Intermediate, 

Organizational, Depot or N/A. 

(4) Using the drop-down menu select the Status of Training as Currently 

Being Trained, Not Being Trained, or Not fully supported through 

current training. 

(5) Click on the Type of Training hyperlink and select/unselect the Type 

of Training. Click on OK. 

 

Figure 5-10 TYPE of TRAINING SELECTION 

(6) Save your entries on the Task tab. 
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 In the Task Attributes Tab: 

 

Figure 5-11 TASK ATTRIBUTE TAB for a TASK 

(1) Select the Component (Platforms, Systems, Subsystems, Components, 

or Non-equipment) from the drop down menu. 

(2) In the Object field click on the down-arrow and select the object 

related to the type selected in Step 1. 

(3) Click on the Condition hyperlink and select the condition from the list.  

(4) Click on the Standard hyperlink and select the standard from the list.  

(5) Click on the Source hyperlink and select the source from the list. 

(6) Click on the Save button to save your selections. 

 Enter the desired information in the Existing Interventions tab and save your 

entries. 

 To add KSATRs for a new Task perform the following steps: 

i.  Click on the KSATRs tab. 

ii.   Click the Edit button. 

iii.  Click on the Select   icon. 

iv.   Select the desired KSATRs for each type by first selecting the type 

from the Type drop-down menu, then checking the desired KSATR 

from the list provided.(Note: By default only KSATRs for the current 

site are displayed, if the desired KSATR is not shown click the Filter  

 icon. This will display all KSATRs of a given type.) 

 Click on the Task title in the left pane. Click on the Submit button in the right 

hand pane to submit your new Task for Approval when completed. Note that 

the status of an item will change from New to Submitted. Other status 

indicators are Approved, Accepted, and Rejected. After it has been submitted, 

new buttons will appear in the left hand screen for Accepted and Rejected. 

Once Accepted a button will appear for Approved. 
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e. For a New Subtask: 

 

Figure 5-12  SUBTASK TABS 

 Enter the Name of the Subtask in the Skill tab and click on the Save button. 

 

Figure 5-13 SUBTASK ATTRIBUTES TAB 

 In the Subtasks Attributes Tab: 

(1) Select the Type (Platforms, Systems, Subsystems, Components, or 

Non-equipment) from the drop down menu. 

(2) In the Object field click on the down-arrow and select the object 

related to the type selected in Step 1. 

(3) Click on the Condition hyperlink and select the condition from the list. 

(4) Click on the Standard hyperlink and select the standard from the list. 

(5) Click on the Source hyperlink and select the source from the list.  

(6) Click on the Save button to save your selections. 

 Enter information in the Existing Interventions tab by clicking on the New  

icon, select the type from the drop down menu and identify the Intervention in 

the field provided. Save your entries when completed. 

 To add KSATRs for a new Subtask perform the following steps: 
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i.  Click on the KSATRs tab.  

ii.   Click the Edit button. 

iii.  Click on the Select   icon. 

iv.   Select the desired KSATRs for each type by first selecting the type 

from the Type drop-down menu, then checking the desired KSATR 

from the list provided.(Note: By default only KSATRs for the current 

site are displayed, if the desired KSATR is not shown click the Filter  

 icon. This will display all KSATRs of a given type. 

 Click on the Subtask title in the left pane. Click on the Submit button in the 

right hand pane to submit your new Subtask for Approval when completed. 

Note that the status of an item will change from New to Submitted. Other 

status indicators are Approved, Accepted, and Rejected. After it has been 

submitted, new buttons will appear in the left hand screen for Accepted and 

Rejected. Once Accepted a button will appear for Approved. 

f. For a New Step: 

 

Figure 5-14 STEP TABS 

 Enter the Name of the Step in the Skill tab and click on the Save button. 

 

Figure 5-15 Step Attributes Tab 
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 In the Step Attributes tab: 

(1) Select the Type (Platforms, Systems, Subsystems, Components, or 

Non-equipment) from the drop down menu. 

(2) In the Object field click on the down-arrow and select the object 

related to the type selected in Step 1. 

(3) Click on the Condition hyperlink and select the condition from the list. 

(4) Click on the Standard hyperlink and select the standard from the list. 

(5) Click on the Source hyperlink and select the source from the list. 

(6) Click on the Save button to save your selections. 

 Enter information in the Existing Interventions tab by clicking on the New  

icon, select the type from the drop down menu and identify the Intervention in 

the field provided. Save your entries when completed. 

 To add KSATRs for a new Step perform the following steps: 

i.  Click on the KSATRs tab.  

ii.   Click the Edit button. 

iii.  Click on the Select   icon. 

iv.   Select the desired KSATRs for each type by first selecting the type 

from the Type drop-down menu, then checking the desired KSATR 

from the list provided.(Note: By default only KSATRs for the current 

site are displayed, if the desired KSATR is not shown click the Filter  

 icon. This will display all KSATRs of a given type. 

 Click on the Step title in the left pane. Click on the Submit button in the right 

hand pane to submit your new Subtask for Approval when completed. Note 

that the status of an item will change from New to Submitted. Other status 

indicators are Approved, Accepted, and Rejected. 

After it has been submitted, new buttons will appear in the left hand screen 

for Accepted and Rejected. Once Accepted a button will appear for 

Approved. 

 After JDTA elements have been completed they should be submitted for 

Review. Submitting an element for review will generate an email to the 

reviewer with a link to the element that was submitted. When an element has 

been accepted a similar email will be sent to the approver with a link to the 

element. This email functionality can be disable by the user by going to the 

Preferences tab under their "My Profile" tab and unchecking the "I want to 

Receive Emails when changes to JDTA status affects me" checkbox. Center 

Administrator can also disable this feature. 

NOTE: 

JDTA items can also be "Bulk Submitted, Accepted and Approved" 

by clicking on the Bulk Submit/Accept/Approve Icon   and 

selecting the appropriate action from  the drop-down menu. 
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WARNING: 

If a JDTA element is Rejected there is no way to "UnReject" 

the element. It is essentially a "dead" element. Careful 

consideration should be taken before Rejecting JDTA 

elements. 

 

5.5.1 To Create a Job, Duty, Task, Subtask, or Step From OCCSTDS 

OCCSTD data may also be used to develop Duty, Task, Sub-task, and Step elements. To use 

OCCSTD data follow these steps: 

1. Highlight the parent element, Job for Duty, Duty for Task, Task for Sub-task and Sub- 

task for Step. 

2. Click the "Create from OCCSTD" icon.   

3. Expand the OCCSTD tree (right pane) to the desired element. 

4. Click on the checkbox next to the desired elements to select them. 

5. Click the Save button after selecting the desired OCCSTD elements. 

6. Complete the rest of the JDTA information for the new element. 

7. Modify the Verb, as required. 

8. Click the “Save” button. 

 

5.5.2 To Convert Current Job, Duty, Task, Subtask, or Step to an OCCSTD 

1. Locate any existing Job, Duty, Task, Sub-Task or Step that is not an OCCSTD. 

2. Select the existing Job, Duty, Task, Sub-Task or Step.  

3. Click on "Turn to OCCSTDs" button within toolbar. 

4. Select the correct Center from the list of centers to display the OCCSTDS. 

5. Select a single OCCSTD.  

6. Click the “Save” button. 

7. Once the page has refreshed, update the Job, Duty, Task, Subtask, or Step as required. 
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5.6 TO CREATE A NEW VERSION OF AN APPROVED JOB, DUTY, 

TASK, SUBTASK, OR STEP: 

Duties may be updated before or after they are approved. Updating an approved Duty will 

generate a new version of the Duty and any associated Tasks, Subtasks, or Steps. To 

update a Duty, Task, Subtask or Step perform the following steps: 

Step 1. Highlight the element to be updated. 

Step 2. Click on the Create New Version  icon. A new version of the approved 

skill is created, flagged, and ready to be edited. The Version drop-down 

allows the user to switch between the different available versions. 

Step 3. Click the Bulk Actions icon   and click on Update from the drop down 

menu. Step 3. Click on the "Skills to update" hyperlink from the update 

screen, see figure 

below. By default all subordinate Tasks/Subtasks will be selected. 

Step 4. From the "Skills to Update" screen uncheck skills that will not be updated, click 

OK when finished. 

Step 5. Fill in the rest of the blocks on the Update screen. These links are the same as 

when creating a JDTA element. After selecting one of the links the user can 

select either "Add to all" or "Remove from all" to add or remove the selected 

element from all Tasks/Subtasks, see figure below. When finished click 

Update. 

Step 6. Click on the TTA tab and complete all TTA data entries as needed. 
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Update Screen 

5.7 COPY AND PASTE JDTA ELEMENTS 

To Copy a JDTA element from one place to another follow these steps: 

1. Highlight the element to be copied (Occupation, Job, Duty, Task, Sub-task or Step). 

2. Click the Copy icon. 

3. Highlight the parent element of the new location (Center for Occupation, Occupation for 

Job, Job for Duty, Duty for Task, Task for Sub-task, and Sub-task for Step). 

4. Click the Paste icon and then choose one of the following options: 

a. Paste - This will copy only the selected element and NOT the associated sub- 

elements. 

b. Paste with Children - This will copy the selected element and all sub-

elements.  

c. Move - This will copy the selected element and sub-elements and delete the 

original element and sub elements. 
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5.8 IMPORTING CTTL DATA 

It is possible to import CTTL data from AIM II v5. To create the required Excel spreadsheet 

perform the following steps: 

1. From AIM II v5 Main Menu select Utilities. 

2. From the Utilities Menu select Reporting. 

3. From the Reporting screen select the Data Output tab. 

4. From the Data Output tab highlight Output CTTL to Excel. 

5. From the Options Menu select Generate, this will display the Select Course screen. 

6. From the Select Course screen highlight the desired course and select Select from the 

Main Menu. This will display the Select Output File window. 

7. In the Select Output File window select a location and name for the output file, 

remember this name and location. 

8. Acknowledge file creating message and exit AIM II v5. 

To import the CTTL data created in the previous steps into CPM JDTA perform the following 

steps: 

1. From the JDTA tab select the appropriate Occupation and  Job. 

2. With the appropriate Job highlighted select the Import icon  . 

The CTTL Data Import Delimited Text (*.csv) screen appears, input or browse to the 

file that was created earlier from AIM II v5 and click Upload. 

3. Once the file has been uploaded a screen displaying CTTL data will appear. 

4. From the CTTL Data screen select the desired Duties and tasks for the Job that is 

highlighted in the left pane by clicking on the check box next to the desired item in the 

CTTL Data screen. 

5. This process can be used to select Duty, Task, Subtask and Step.  

For Subtasks and Steps be sure to use the drop-down menu on the Skill column to select the 

appropriate level (Subtask or Step). 

5.9 CENTER FILTERING 

Starting at the Task level some of the available inputs may have been filtered by the center at the 

Data tab. Refer to the table below to identify where inputs may be filtered. 
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Input JDTA tab effected 

Verb Task, Subtask and Step 

Platform, Systems, Subsystems, Components, 

Non-Equipment 

Task, Subtask and Step Attributes 

Conditions Conditions link on Task, Subtask and Step 

Attributes tab 

Standard Standards link on Task, Subtask and Step 

Attributes tab 

Filtering can be turned off by selecting the (Show All) option for Verbs, Platforms, Systems, 

Subsystems, Components, and Non-Equipment. For Conditions and Standards clicking on the 

Filter icon will toggle filtering on/off. 

5.10 JDTA SEARCH 

The search function allows the user to search for desired data elements within the JDTA, at 

a specific JDTA level, Center, Occupation, etc. It should be noted that the higher the search 

the longer the search will take. 

To search existing JDTA data follow the steps below: 

Step 1. Highlight any area on the JDTA tree (left pane).  

Step 2. Click on the Search icon  . 

Step 3. Select search criteria by entering text in the Skill Text field, selecting a different 

Status from the drop-down list, and/or clicking on the appropriate hyperlinks, 

then selecting search data by checking desired checkboxes. See the figure 

below. 

Step 4. When all search criteria have been selected click the Search button. 

Step 5. After reviewing the search results select "All JDTA" from the drop down 

menu to see all JDTA data. See figure below. The search results will remain 

until the user logs off or another search is performed. 
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JDTA Search Screen 

 

JDTA Drop Down Menu 

5.10.1 Printing Search Results 

Reports can be generated in PDF, RTF or Excel formats. To generate a report follow the 

steps below. 

Step 1. Highlight the level where you want the report to begin, Occupation, Job, 

Duty, etc. 

Step 2. Click on the Print Icon 

Step 3. Select one of the five print options (Hierarchy to PDF, Hierarchy to RTF, 

Related Materials, Unassociated Tasks, or Export to Excel). 
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5.11 IMPORTING FROM EXCEL SPREADSHEET 

JDTA information can be collected via Excel spreadsheet and then validated and imported 

into CPM. CPM can generate a blank spreadsheet with the appropriate columns needed for 

JDTA data capture. To generate a blank spreadsheet follow these steps: 

Step 1. From the CPM Home screen select the JDTA tab. 

Step 2. Click on the Import Icon   and select "JDTA Blank Spreadsheet". 

Step 3. Depending on browser (IE, Chrome, Firefox) either make note of where the 

spreadsheet is being saved or choose a location to save the spreadsheet to. 

The blank spreadsheet is now ready for use. 

The spreadsheet can be used to populate an entire new Occupation or any part thereof. It is 

important to remember that when validating the spreadsheet the JDTA element that must be 

highlighted is one above where the spreadsheet information starts. For example, if an entire 

Occupation through Steps is being created then the Center must be highlighted during 

validation. The spreadsheet contains the following data fields: 

• Type: Occupation, Job, Duty, Task, Subtask, or Step. This is a drop down menu. 

• Skill Text: The text of the skill. This is free text. 

• Proficiency Level. SPL1, SPL2, SPL3. This is a drop down menu. 

• OCCSTD Task ID: The Task ID from OCCSTD. This is free text. 

• Task Level: Organization, Intermediate, Depot, N/A. This is a drop down menu. 

• Status of Training: Currently Being Trained, Not Being Trained, Not fully 

supported through current training. This is a drop down menu. 

• Type of Training: Formal, PQS, JQR, RTM, OJT, Other. Separate multiple entries 

using the semi-colon “;”. This is free text. 

• Object(s): Platform, System, Subsystem, Component, Environment, Non-Equipment, 

Tool. Objects can only be assigned at the Task level or lower. When entering Objects 

in the spreadsheet the format is: <Object>:<Name>, for example Platform:CVN-70. 

Separate multiple entries using the semi-colon “;” and include the object type with 

each entry, for example Platform: CVN-70; Environment: At Sea. This is free text. 

• Condition(s): Under what condition(s) is the task performed. Separate multiple 

entries using the semi-colon “;”. This is free text. 

• Standard(s): To what level of proficiency does the task need to be performed. 

Separate multiple entries using the semi-colon “;”.This is free text. 

• Task Source: Reference publication for the task. Separate multiple entries using the 

semi- colon “;”.This is free text. 

• Knowledge, Skills, Abilities, Tools, and Resources (KSATRs). these are free text. 

Separate multiple entries using the semi-colon “;”. 

• Safety Hazard Severity: Minor, Marginal, Critical, Catastrophic. This is a drop 

down menu. 
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• Criticality of Performance: Minor, Marginal, Critical, Catastrophic. This is a drop 

down menu. 

• Task Delay Tolerance: Low delay tolerance, High delay tolerance. This is a drop 

down menu. 

• Frequency of Performance: At least annually, At least every 6 months, At least 

monthly, but less than twice a week, Twice a week or more. This is a drop down 

menu. 

• Probability of Inadequate Performance: Never performed correctly, Less often than 

other tasks, About as often as other tasks, More often than other tasks. This is a drop 

down menu. 

• Difficulty of Performance: No Training Required, Task requires 1 to 3 days to learn, 

Task may be learned in 1 to 2 weeks, Task may require up to 1 month or more to learn. 

This is a drop down menu. 

• Task Learning Difficulty: No Training Required, Task requires 1 to 3 days to learn, 

Task may be learned in 1 to 2 weeks, Task may require up to 1 month or more to learn. 

This is a drop down menu. 

• Percent Performing: 0 to 24% of the personnel perform this task, 25 to 49% of the 

personnel perform this task, 50 to 74% of the personnel perform this task, 75 to 100% 

of the personnel perform this task. This is a drop down menu. 

• Percentage of Time Spent on Performance: Task is not performed, Less time spent on 

this task than most other tasks, Same amount of time spent on this task as most other 

tasks, More time spent on this task than most others. This is a drop down menu. 

• Immediacy of Performance: Task first performed within 2 to 4 years, Task first 

performed within 1 to 2 years, Task first performed within 6 months, Task 

performed during first 3 months. This is a drop down menu. 

Once all data has been entered and saved in the spreadsheet it must be validated in CPM, 

to validate the spreadsheet follow these steps: 

Step 1. From the CPM Home screen click on the JDTA tab. 

Step 2. Highlight the level above the level where the JDTA data begins, for 

Occupation highlight Center, for Job highlight the Occupation, etc. 

Step 3. Click on the Import Icon   and select "JDTA Validate". 

Step 4. From the JDTA Validate screen browse to the location of the 

completed spreadsheet. 

Step 5. Once the validation process is complete Save or Open the validation 

spreadsheet.  
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Step 6. The validation process has four potential outcomes: 

a. No issues with the data, spreadsheet is ready to be imported into CPM. 

b. Blue background. This data is not in the database and will be created, 

spreadsheet is ready to be imported into CPM. 

c. Yellow background. This data is not in the database. The data will import but 

may not be created as expected. 

d. Red background. This data is incorrect. The import process cannot complete 

until this is fixed. 

Step 7. If there is no incorrect data (red background) the spreadsheet may now be 

imported into CPM. Any incorrect data (red background) must be fixed before 

importing into CPM. NOTE, if the Type field has a red background the 

problem may be that the incorrect JDTA element was highlighted (i.e. 

highlighting Center with data that starts at Duty). 

Once the database is ready for import follow these steps: 

Step 1. From the CPM Home screen click on the JDTA tab. 

Step 2. Click on the Import Icon   and select "JDTA Import". 

Step 3. From the JDTA Import screen browse to the location of the completed 

spreadsheet, not the location of the validation spreadsheet. 

Step 4. With the location of the spreadsheet selected, click the Upload Button. 

Step 5. For any items that were highlighted in Blue or Yellow, you can try to match the 

entry from the spreadsheet with an existing entry in CPM: 

a. Choose which tab to work on: Object Condition, Standard, Source, 

KSATRs by clicking on the tab. If there is no data to be matched, the 

screen will not show any Imported Text. 

b. Click on a line of Imported Text, then click the Select Icon. 

c. Use the Find box to enter search criteria to narrow down the results, then 

Select the Search button. 

d. Select an existing entry in the database that matches the one being 

imported and click the Select button. 

e. Continue to match entries on each tab until all entries have been matched 

or determined that no match can be found and a new entry will be created 

instead. 

f. Select the Import button to import the data. 
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Step 6. Once the upload is complete verify the data imported correctly by viewing the 

JDTA structure in the left pane. 
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6.0 PROJECTS 

The Projects tab provides an area where you can: 

 Create and manage Projects 

 Develop a Training Project Plan (TPP) and Training Course Control Document (TCCD) 

for Curriculum 

 Develop Curriculum Outline of Instruction (COI) 

 Develop Reports 

6.1 PROJECTS WINDOW 

Selecting the Projects tab from the CPM Homepage opens the Projects window. The Projects 

default to My Projects in the drop-down, and lists the projects in which you have been designated 

as a Team Member and the projects you created. From the drop-down arrow you can also select 

All, Active, Testing, and Inactive projects. From this window you can create a New  Project, 

Show Details of an existing project, Deactivate     a Project you created, Export  a Project 

to EDE when completed, or Import  . The project Resource Requirements List (RRL) from 

the EDE. Refer to Figure 6-1. 

 

Figure 6-1. Projects 



Content Planning Module (CPM) User’s Manual  PROJECTS 

Release 5.15  6-2 

6.1.1 To create a New Project: 

From the Projects window click on the New  project icon. This will open a window where you 

can enter the data for: 

 Title 

 Status 

 Center 

 Start Date 

 End Date 

The software automatically captures your name for Owner and the Status defaults to Incomplete. 

The new project will be added to the list when you click on the Save button 

6.1.2 Search 

Searching for a specific Project can be done two ways, either by searching by keyword or 

by various Project attributes; CIN, Title, Center, Status, Owner, or State. 

6.1.2.1 Project Attribute Search 

To search by Project Attributes click on the search  icon and select which attribute values 

to search for, see figure below. 

After selecting the Project attributes click the Search button. A list of matching Projects 

will appear in the left pane. 

6.1.2.2 Keyword Search 

To search for a Project by a keyword or phrase, type the text in the "Find" textbox and click the 

Search button. If the keyword or phrase is in the Project title the Project Title will appear in the 

left pane. The search is limited to the area highlighted in the left pane. 

6.2 PROJECT MANAGEMENT 

Project Management provides an area where you can identify Team Members, create 

Assignments for the Team and develop a Training Project Plan (TPP) and Training Course 

Control Document (TCCD). 

To add project management data: 

Step 1 From the Projects window highlight the desired project in the list and click on the 

View   icon. Refer to Figure 6-1. 
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Step 2 Open the Project Management folders by clicking on the adjacent ‘+’ block.  

Step 3 Click on “Project Management”. This will open the project properties window 

that was created when the project was created. The Title, Start Date, End Date and 

Owner and can be edited by clicking on the Edit button. Refer to Figure 6-2. 

 

Figure 6-2. Project Management Window 

The Project Management window contains folders for identifying: 

 Project content information  

 Team Members  that are going to work on the project, 

 Assignments  

 Change Record   

 Course information  contained in both TPP and TCCD 

 TPP information , and 

 TCCD information . 

6.2.1 Team Members 

To identify the team members responsible for the project: 

Step 1 Click on the Team Member folder in the Project Management tree structure. This 

will open the Team Members window that displays the Name of all Active CPM 

Users. Refer to Figure 6-3. 

Step 2 Click the Edit button then select the users that will be members of the team for the 

project by clicking on the member’s Role column, clicking on the down arrow, 

and selecting from one of the following for each of the members: 
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a. Content Developer 

b. Instructional Designer  

c. MT (MPA) - COI 

d. Project Editor  

e. Rating Lead 

f. Subject Matter Expert  

g. TCCD Approver 

h. TPP Approver. 

NOTE: 

The Project role supersedes the CPM System role, for example 

someone with a "View Only" system role can be granted "Project 

Editor" for a project and will have broad authority with that 

project. 

Step 3 Click on the Save button to save your selections. 

 

Figure 6-3. Team Members 

6.2.2 Assignments 

The Assignments folder will contain all the Assignments of the project. When the Assignments 

are added here they are also added to the Assignments on the Homepage for all Team Members. 

The Assignments menu items consist of: 

  New icon – Create a new Assignment 

  Delete icon – Delete an Assignment from the list 

To create a new Assignment: 

Step 1 Open Project Management folder by clicking on the adjacent ‘+’ block.  

Step 2 Click on the Assignments folder. 
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Step 3 Click on the New icon. Refer to Figure 6-4. 

 

Figure 6-4. Assignments 

Step 4 Enter the desired information in the following fields: 

 Title 

 Start Date 

 Status 

o Not Started  

o In Progress  

o Completed 

o Waiting 

o Deferred 

 End Date 

 Priority 

o Low 

o Normal 

o High 

 Note 

Step 5 When complete click on the Save button. The Assignment will appear in the list 

in the Assignment Title pane and on the Home Page by Start Date and Title. Once 

an Assignment has been added to the database, you will be able to assign a user to 

the Assignment. Refer to Figure 6-5. 
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Figure 6-5. Assigned Users 

Step 6 Click on Assigned Users to select the user(s) the assignment was created for. 

Refer to Figure 6-6. 

 

Figure 6-6. Selecting Assigned Users 

NOTE: 

The creator of the assignment is selected by default and can be unselected. 

Step 7 Click on the select box to enter a check mark and identify the Team Member that 

the Assignment is intended for. 

Step 8 Click on the Save button. 
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To delete an Assignment from the list: 

Step 1 Open Project Management folder by clicking on the adjacent ‘+’ block.  

Step 2 Click on the Assignments folder. 

Step 3 Click on the Assignment you want to delete in the list.  

Step 4 Click on the Delete icon. 

Step 5 Click on OK when asked for confirmation to delete the Assignment or Cancel to 

return to the folder without deleting the Assignment. 

6.2.3 Training Project Plan (TPP) and Training Course Control Document 

(TCCD) 

A curriculum development project begins with planning, i.e., the gathering of information and 

the building of a plan for training material development. The output product of curriculum 

development planning is the Training Project Plan (TPP), which upon approval by the 

Curriculum Control Authority (CCA) becomes the authorization to undertake a new course 

development project. 

NOTE: 

Before starting a TPP or Project, review NETC policies related to 

Front End Analysis (FEA) and Business Case Analysis (BCA). 

A TPP consists of the following elements (as applicable) in the ILE Project portion of the CPM: 

 TPP/TCCD Course information 

 Course Overview 

 Course Status 

 Development Method 

 Justification for the Course, that includes: 

o References 

o Reason for and Anticipated Benefits of the Proposed Project 

o Summary of Differences (for a Revision) 

o Impact If Not Approved 

 Milestones 

 Safety Risks and Hazardous Materials 

 Purpose of Course 

 Occupational Classification/Prerequisite 

 Training Sites/Course Data 

 Resource Requirements List (RRL) 

When the TPP is approved by the CCA the emphasis changes to the development of TCCD 

materials. 
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A TCCD consists of the following elements (as applicable) in the ILE Project portion of the 

CPM: 

 TPP/TCCD Course information 

 Foreword 

 Course Overview 

 Trainee Data 

 Purpose of Course 

 Occupational Classification/Prerequisite 

 Instructor/Support Manning 

 Training Sites/Course Data 

 Course Master Schedule (CMS) 

 Resource Requirements List (RRL) 

6.2.3.1 TPP/TCCD Course Information 

The TPP/TCCD course folder contains information that is common to both the TPP and the 

TCCD and is where you will enter the following course information, as applicable, in the fields 

provided and save the information to the database: Refer to Figure 6-7. 

 Course Title 

 Course Status: Incomplete, Complete, Locked for Review, or Approved 

 CIN (Course Identification Number) 

 Starting Fiscal Year 

 Check box to identify CNATT compliant ERL data 

 Training Type 

 Prepared By 

 Prepared For 
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Figure 6-7. TPP/TCCD Course Information 

6.2.3.2 Foreword 

The foreword is not a required element of the TCCD but is a place to explain to reviewers any 

unique aspect of the course, which may not be apparent from the basic data. 

6.2.3.3 Course Overview 

List the course subjects. Note any changes from the previous project plan. For a new course this 

will be a description of the skills and knowledge to be attained. This is not intended to be the 

equivalent of a curriculum outline, or to contain objectives. The overview helps identify what the 

course will actually contain. 

6.2.3.4 Course Status 

 New - course or new to your Training Activity. 

 Revision - A modification to any course terminal objective, increase in course length, or 

training material change that requires additional resources. 

 Deactivation - Course will no longer be taught at your activity, or another activity for 

which you are CCMM for, and is not being replaced by another course. 

6.2.3.5 Development Method 

The Development Method element of the TPP contains information about the documents that 

will be produced, Learning Objects, and Mode of Instruction for the course if the TPP is 

approved by the CCA. Refer to Figure 6-8. 
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Figure 6-8. Development Method 

6.2.3.6 Trainee Data 

The Trainee Data element of the TCCD consists of personnel physical requirements, security 

clearances, obligated service, and NOBC/NEC/MOS earned. Refer to Figure 6-9. 

 

Figure 6-9. Trainee Data 

6.2.3.7 Justification 

There must be a reason (or reasons) to undertake the development of a new course or the revision 

of an existing course.  The justification for initiating the development of a new course or the 

revision of existing training materials can come from: 

 Navy Training Plans (NTPs) (OPNAVINST 1500.8) 

 Tasking by higher authority 

 Internal course reviews and local command initiatives 

 External course reviews 



Content Planning Module (CPM) User’s Manual  PROJECTS 

Release 5.15  6-11 

 Surveillance and external feedback 

 Training appraisal 

1.  Reference - The principal document for stating billets, personnel, military 

construction, and training material support requirements of the system, subsystem, 

components, or non-hardware oriented development, to produce trained and qualified 

personnel required to install, operate, maintain, or otherwise use the same being 

introduced into the Navy. 

2.  Reason for and Anticipated Benefits of the Proposed Project: new course, revision, or 

cancellation: 

New - Justification for expenditures of funds to support new training: No existing 

training for Fleet need; new hardware requiring operator and/or maintenance skills; 

NTP driven. 

Deactivation - Fleet no longer requires this training, training is not cost effective: 

Obsolescence due to platform or equipment upgrades: training can be accomplished 

on- board: Training Realignment - course is no longer taught at one or more locations. 

Change Directive: Tasking document which directs course revision, cancellation, or 

new course development. Examples include: Navy Training Requirements Review 

(NTRR) action items, Technical Training Audit action items, etc. 

3.   The Summary of Differences is added when a TPP is being developed for a revision 

to a course. In general, a revision means that the course mission has changed, course 

length is increased, or additional resources are required. Identify the differences from 

the approved training material. 

4.  Impact If Not Approved: Clearly describe the impact on fleet requirements and 

capabilities if the proposal is not undertaken. 

6.2.3.8 Milestones 

A time-phased narrative commencing with TPP approval, milestones shall include identification 

of major developmental products or events relating to the training materials development method 

selected, and end with implementation. Projected completion dates for each key event shall be 

indicated. 

To edit an existing Milestone, highlight the Milestone and click the Edit button. To delete a 

Milestone, highlight the Milestone and click the Delete icon. 

Click on the New icon and enter the Title, Location, Start and End Dates. A Note field is 

provided to explain the Milestone in detail if required. When completed, click on the Save button 

to save the milestone for the project. Refer to Figure 6-10. 



Content Planning Module (CPM) User’s Manual  PROJECTS 

Release 5.15  6-12 

 

Figure 6-10. TPP Milestones 

6.2.3.9 Safety Risks and Hazardous Materials 

There are two check boxes, one for whether or not the course is high risk and one for whether or 

not the course contains hazardous materials. There is also a text box to add any other related 

information. 

6.2.3.10 Purpose of Course 

For a new course you should answer the following questions: Train who?; To do what?; Where?; 

Under what conditions?; What degree of qualification will be brought about by this training? 

6.2.3.11 Course Mission Statement 

The Course Mission Statement is closely related to the "Purpose of Course", however, some 

commands prefer Course Mission Statement. Please follow local guidance when populating 

each option, they will both print in related documents such as the Training Project Plan (TPP) 

and Training Course Control Documents (TCCD). 

6.2.3.12 Occupational Classification/Prerequisite 

 List the NEC/NOBC/MOS awarded upon completion of the course. If no classification 

exists or if a classification has been requested say so here. 

 Describe the personnel eligible to attend the course. 

6.2.3.13 Training Sites 

Training Activity to which the Course Data applies. The Course Data is required for each activity 

that teaches the course. Refer to Figure 6-11. 
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Figure 6-11. TPP/TCCD Training Sites 

To add a Training Site: 

Step 1 Click on the Training Sites element or an existing Training Site.  

Step 2 Click on the  New icon. 

Step 3 Enter the Site Name and the CDP if assigned. 

NOTE: For a New TPP enter information in the Planned columns. For a Revision 

TPP enter information in both Current and Planned. 

Step 4 Enter the Class and Lab hours in the appropriate fields. Enter hours in the PA 

(Practical Application) fields, a CNATT identifier, if applicable. 

Step 5 Enter the Minimum and Maximum Class Capacities. 

Step 6 Enter the number of times the course will be taught in a year in the Class 

Convenings field. 

Step 7 Enter the number of students you expect will graduate from this course in a year 

in the Student Throughput field. 

Step 8 Enter the Manpower Totals expected to be needed to conduct this training at this 

site. 

Step 9 Enter any additional Site Considerations in the "Site Considerations" text box.  

Step 10 Click on the Save button. Average on Board will be computed by the software. 

6.2.3.13.1 CMS 

The CMS Events Module allows the user to manage the CMS using training events. In the CMS 

Events Module a Period length is 60 minutes, this is adjustable. 

There is no restriction on the order in which events can be placed. The Events will be displayed 

colette.l.hutton1
Highlight
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in the order specified by the user, not necessarily in the order of the Sections within the COI. 

Initially topics are created from the Curriculum Outline of Instruction with their associated 

Section Number.  When creating a new Event, you are prompted to select which Section to 

associate to it. 

The following Event Types are available from a dropdown menu on the Type column: 

 Administrative Time 

 Aircraft 

 Alternate Event 

 Brief 

 Classroom 

 Clinical 

 Computer Based Training - Classroom 

 Computer Based Training - Lab 

 Field 

 Final Comprehensive Test 

 General Military Training 

 Homework 

 Knowledge Test 

 Lab Practical 

 Laboratory 

 Lunch 

 Midcourse Comprehensive Test 

 Performance Test 

 Physical Readiness Test 

 Physical Training 

 Practical Comprehensive Test 

 Practical Work Comprehensive 

 Pretest 

 Quiz 

 Remedial Study 

 Review 

 Shop 
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 Trainer 

 Trip 

 Written Test 

The Length (H:MM) column denotes the length of the event in hours and minutes. If the time is 

input in strictly minutes and it exceeds 60 minutes the length will be converted to hours: minutes 

when the CMS is saved. The CMS output is listed in Periods which are 60 minutes in length, 

therefore if the Length is 2:00 (2 hours) the CMS output will list two Periods for the Event, any 

fraction of an hour will be listed as an additional Period. For example if the Event Length is 2:30 

(2 hours 30 minutes) the CMS output will list three Periods. 

The Ratio column denotes the Student/Instructor Ratio for the event. The default Student value 

comes from the Planned Maximum Class Capacity of the Learning Site. 

The Bottleneck column denotes a restriction in training which requires a different 

Student/Instructor ratio than normal for this event. 

The Justification Text box at the bottom of the pane is used for a brief description of the reason 

for a Bottleneck. The Justification for the Bottleneck can be described in detail in the CMS sub- 

element "Justification". 

Each Learning Site has their own CMS based on the CMS of the CCMM. Learning Sites other 

than the CCMM can only change the student/instructor ratios and bottleneck ratios. Adding 

events or resequencing events can only be done to the CCMM CMS. 

6.2.3.13.1.1 CMS Events Options 

6.2.3.13.1.1.1 Add 

To Add Events to the CMS complete the following steps: 

Step 1  With the CMS element highlighted in the left pane, click the Edit button.  

Step 2  From the icon bar select the "New" icon. 

Step 3  Select the Section to associate with the new event, if no Section is to be associated 

with the new event select "Do not associate to a Section" at the top of the list. 

Step 4  Click on the newly added line item to edit, all fields except the Section Number 

can be edited. When done, click the Save button. 

6.2.3.13.1.1.2 Resequencing 

To resequence events complete the following steps:  

Step 1 Click on the Resequence icon. 

Step 2 Drag and drop events into the desired order.  

Step 3 Click the Save button. 
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6.2.3.13.1.1.3 Delete 

The Delete option is used to delete highlighted Events. Highlight the desired Event and select the 

Delete icon from the Icon menu bar. 

6.2.3.13.1.1.4 Add Missing Sections 

To add missing Topics to the CMS select the Add Missing Sections icon from the icon bar. All 

Sections from the COI not already included in the CMS will be added. Period, Ratio, and 

Bottleneck columns may require further editing. 

6.2.3.13.1.1.5 Change the Section associated to an Event 

To change which section is associated to a particular event, highlight the event in the list and 

click the Select button in the toolbar. This displays a list of Sections within the Course. 

6.2.3.13.2 Facilities 

The top portion of the Facilities screen is used to identify Compensation Funding for Facilities, 

there are text boxes for the Amount, Shortfall, and the Source of the Compensated Funds. The 

Facilities section is used to describe any physical alterations required to conduct training at a 

training site, if no alterations are required it should be stated. 

6.2.3.13.3 Funding 

The top portion of the Funding screen is used to identify Compensation Funding, there are text 

boxes for the Amount, Shortfall, and the Source of the Compensated Funds. The bottom portion 

of the screen has eight columns, the first three columns are for the Appropriation Code, the 

Activity Group Code and the Expense Category Code, the remaining five columns are for the 

amount of funding starting with the current fiscal year and going out two more years. 

6.2.3.13.4 Manpower 

The top portion of the Manpower screen is for Compensated Billets there are text boxes for the 

Compensated Billets, the Billet Shortfall, and the Source of where the billets came from. The 

bottom portion of the screen is a billet matrix for the current fiscal year and the following two 

years. 

There are five different Personnel Types; Officer, Enlisted, Civilian, Contractor, and Support. 

For each Personnel Type there are five different Billet Types: 

1. Required. This is the number of billets required to conduct training. 

2. Authorized. This is the number of billets authorized by Navy Manpower. 

3. Compensated. This is the number of billets being compensated from another source, this 

should match the information in the top portion of the screen. 

4. Available. Available billets are used when cancelling a course, these are billets identified 

as being made available to the Navy. 

5. Delta. The Delta is the difference between the combination of Authorized Billets and 

Compensated Billets against Required Billets. (AB + CB = RB). For example if there are 
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2 Authorized Billets and 2 Compensated Billets but the Required Billets is 6, the Delta 

would be 2. (2 + 2 = 6, difference or Delta is 2). 

6.2.3.13.5 RRL 

The RRL screen is initially blank, to add resources to the TPP/TCCD follow these steps:  

Step 1 From the drop-down menu select the desired Resource Category. 

Step 2 Once the Resource Category has been selected Click the Edit button. 

Step 3 Click on the checkbox next to the desired resource. More than one resource can be 

selected but it is recommended only one resource be selected at a time. 

Step 4 Once a resource has been selected fill in the information for Quantity On Hand 

and Quantity Required. 

Step 5 Click the Save button. 

If the desired resource is not seen in the list of resources click on the filter icon to turn filtering 

off, this will show a complete list of available resources. 

6.2.3.14 Additional TCCD Information 

Once the TPP has been Approved the TPP/TCCD will split into two separate sections the 

following information can then be entered by selecting the appropriate section from the tree 

structure in the left pane. 

6.2.3.14.1 Foreword 

The foreword is not required but serves as a place to include amplifying data that may not be 

readily apparent from the basic data. 

6.2.3.14.2 Trainee Data 

Trainee Data includes the following four sub-categories: 

1. Personnel Physical Requirements, any physical attribute the trainee must have prior to 

attending training. 

2. Security Clearance, the Security Clearance required to attend the course, not necessarily 

the clearance of the course, for example, an unclassified course may be taught in a secure 

building, the trainee would need the security clearance that would allow entry into the 

building. 

3. Obligated Service, any time the trainee is require to extend his service agreement to 

attend the training. 

4. NOBC/NEC/MOS Earned, any job specialty classification earned by completing the 

training. 

6.2.3.14.3 Instructor/Support Manning 

Instructor and support personnel manning numbers are entered here. 
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6.2.3.15 Bulk Approving Course Objectives 

If the course is selected, the first time Bulk Approve is clicked, all completed section objectives 

are listed and can be selected and approved. The second time Bulk Approve is clicked, all 

completed lesson objectives are listed and can be selected and approved. 

Step 1 Select the course in the Curriculum Development tree structure. 

Step 2 Click on the Bulk Approve   icon and select Approve from the selection.  

Step 3 Check the Objectives to approve from the list that appears. If no Completed 

Objectives are available to approve, acknowledge the message that states this.  

Step 4 Click Save to approve the selected objectives. 

6.2.3.16 Approving a TCCD/Course/Project 

In order to approve a TCCD or the Project as a whole, the content and objectives of the course 

have to be approved first. Then the Project can be approved. 

Step 1 Select the desired project on the Projects tab and click View.  

Step 2 Select Project Management and then click Edit. 

Step 3 Select Approved from the Status drop-down list box. 

Step 4 Click Save and OK to approve the TCCD, Course, and Project. 

6.2.4 Testing Plan  

The Testing Plan allows for the development of a NAVEDTRA compliant plan. Placeholder 

sections have been used for documents that are created outside the CPM program. 

6.2.4.1 To Create a Test Plan 

Step 1 Open the Project Management folder by clicking on the adjacent ‘+’ block.  

Step 2 Click on the Testing Plan folder. 

Step 3 When the pop-up for no testing appears, select the “OK” button to create. 

Step 4 Enter data in all of the required fields. 

Step 5 Click on Save when asked for confirmation or Cancel to return to the folder 

without editing the Testing Plan. 

Step 6 Select the Minimum Passing Grade subfolder and then click Edit. 

Step 7 Enter data in the text box. 

Step 8 Click on Save when asked for confirmation or Cancel to return to the folder 

without editing the Testing Plan. 
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Step 9 Select the Justification Comments subfolder and then click Edit. 

Step 10 Enter data in the text box. 

Step 11 Click on Save when asked for confirmation or Cancel to return to the folder 

without editing the Testing Plan. 

Step 12 Select the Test Procedures subfolder and then click Edit. 

Step 13 Enter data in the text box. 

Step 14 Click on Save when asked for confirmation or Cancel to return to the folder 

without editing the Testing Plan. 

Step 15 Select the Matrix subfolder and then click Edit. 

Step 16 Enter the weight of each assessment (developed in the Curriculum Development 

section, below). Verify the data entered for the assessments. Only assessments 

entered below will be added to the matrix and displayed here. 

Step 17 Click on Save when asked for confirmation or Cancel to return to the folder 

without editing the Testing Plan. 

6.3 CURRICULUM DEVELOPMENT 

The curriculum development portion of the project is where you will select the performance 

requirements and develop the Curriculum Outline of Instruction (COI) for the Course. 

6.3.1 Performance Requirements 

Under the Performance Requirements folder you will select the Occupations, Jobs, Duties, 

Tasks, Subtasks, and Steps for the training you are developing. Refer to figure 6-12. 
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Figure 6-12. COI Performance Requirements – Occupations 

To select the applicable Occupation for your Center: 

Step 1 Open the Curriculum Development folder by clicking on the adjacent ‘+’ block. 

Step 2 Open the Performance Requirements  folder by clicking on the adjacent ‘+’ 

block. 

Step 3 Click on the Occupation sub-folder to open the Occupations window for your 

Center. 

Step 4 Click on the check block/s to select the Occupation/s that will take the course.  

Step 5 Click on the Save button. 

To select the applicable Jobs for the Occupation/s selected: 

Step 1 Click on the Jobs sub-folder to open the Jobs for the Occupation/s selected.  

Step 2 Click on the check block/s to select the Job/s. 

Step 3 Click on the Save button. 

To select the applicable Duties for the Job/s selected: 

Step 1 Click on the Duties sub-folder to open the Duties for the Job/s selected.  

Step 2 Click on the check block/s to select the Duties. 

Step 3 Click on the Save button. 
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To select the applicable Tasks for the Duties selected: 

Step 1 Click on the Tasks sub-folder to open the Tasks for the Duties selected.  

Step 2 Click on the check block/s to select the Task/s . 

Step 3 Click on the Save button. 

To view the applicable Subtasks for the Tasks selected: 

Click on the Subtasks sub-folder to view the Subtasks for the Task/s selected. Suggested 

New Subtasks can be submitted for approval through your CPM System Administrator. Refer to 

Figure 6-13. 

 

Figure 6-13. COI Performance Requirements – Subtasks 

To view the Steps for the Subtasks selected: 

Click on the Steps  sub-folder to view the Steps for the Subtasks for the Tasks selected. 

To select a new version of a skill 

In order to select a new version of a skill in the Performance Requirements tree structure, not 

only does the skill have to be approved first, but the Job has to be approved as well. Once the job 

has been approved, the new version can be selected as noted above. Then the skill can be 

selected just like any other approved skill. 

6.3.2 Curriculum Outline of Instruction (COI) 

The folder identified by the icon  of three books side by side is you course title, identified in 
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the Course Data of your TPP. From this folder you will create the COI for your course that will 

contain: 

 The Course Title 

 Modules that can contain one or more Lessons 

 Terminal Objective for each Lesson 

 Lessons that can contain one or more Sections 

 Enabling Objective for each Section 

In addition to the course icon , a Module is identified by a single diagonal book     , a Lesson 

by a box , a Section by three horizontal lines     and a Terminal or Enabling Objective by a 

plum colored and underline Objective. 

The icons of the COI are color coded to identify their status: 

 Pink – Title linked to a Skill Group 

 Blue – Title linked to a Task 

 Orange – Title linked to a Sub-Task 

 Yellow - Title was developed from a Step 

 Green – Unique Knowledge 

 Gray - No link assigned 

6.3.2.1 Delivery Method 

To enter the delivery method for the Course: 

Step 1 Click on the Course  icon. 

Step 2 Click on the drop-down arrow in the Delivery Method field and select the 

appropriate method. Refer to Figure 6-14. 

Step 3 Click on the Save button. 



Content Planning Module (CPM) User’s Manual  PROJECTS 

Release 5.15  6-23 

 

Figure 6-14. Delivery Method 

To add ISD Considerations information for your Course: 

Step 1 Click on the  ISD Considerations link. Refer to Figure 6-15. 

 

Figure 6-15. ISD Considerations for Course  

Step 2 Click on the desired item, add your comments in the text field.  

Step 3 Click on the Save button. 

6.3.2.2 Adding a Module to a Course 

Modules can be created from Skill Basis: Skill Group or Tasks and Attributes: Ability, 

Knowledge, Resource, Skill or Tool. If no data is present in the database for the Module being 

developed you can select None to add the Module title. 

To add a Module to the COI: 

Step 1 Click on the Title of your course. 

Step 2 Click on the New  icon. Refer to Figure 6-16. 
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Figure 6-16. New Module  

Step 3 Enter the title of the Module in the Module Title field.  

Step 4 Select the delivery method from the drop-down menu. 

Step 5 Select the Skill Basis from the Skills Basis tab: 

1. Click the Select Icon  . 

2. Expand the tree as needed to find the desired Duty, Task or KSATR, see Figure 6-

17. 

 

Figure 6-17. Duties, Tasks, and KSATRs 

3. Click the checkbox next to the desired Duty, Task or KSATR to select it. 

4. Click the OK button. 

5. Click the Save button. 

Step 6 After clicking the Save button click on the  ISD Considerations link. 

Step 7 Add information for the appropriate ISD Considerations for the Module. Refer to 
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Figure 6-18. 

 

Figure 6-18. ISD Considerations for Module 

Step 8 Click on the Save button to save your Module. 

6.3.2.3 Adding a Lesson to a Module 

Adding a Lesson to a Module is accomplished by completing two processes: Adding the title of 

the Lesson to the Module and developing a Terminal Objective Statement to the Lesson. 

To add a Lesson to a Module: 

Step 1 Click on the desired Module of your course in the COI tree structure.  

Step 2 Click on the New  icon. Refer to Figure 6-19. 

 

Figure 6-19. New Lesson 

Step 3 Enter the title of the Lesson in the Lesson Title field.  

Step 4 Select the delivery method from the drop-down menu.  

Step 5 Select the Skill Basis from the Skills Basis tab 
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1. Click the Select Icon  . 

2. Expand the tree as needed to find the desired Duty, Task or KSATR, see Figure 6-

17. 

3. Click the checkbox next to the desired Duty, Task or KSATR to select it. 

4. Click the OK button. 

5. Click the Save button. 

NOTE: 

If a Skill Basis was selected, when you save you will be given the 

option to use the linked JDTA item (for example Task) as the 

default wording for the learning objective. You will be able to edit 

the learning objective. 

Step 6 Click on the  ISD Considerations link. 

Step 7 Click the Edit button to add information for the appropriate ISD Considerations 

for the Lesson. Refer to Figure 6-20. 

 

Figure 6-20. ISD Considerations for Lesson 

Step 8 Click on the Save button to save your Lesson. 

To develop a Terminal Objective Statement (TOS) for the Lesson: 

Step 1 Click on the Lesson   title in the COI tree structure. 

Step 2 Click on Objective. The Objective development window will open. Refer to 

Figure 6-21. 
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Figure 6-21. Objective Development Window 

Step 3 In the Select Type field click on the drop-down arrow and select the desired type 

of entry to begin developing your objective. One or more of the double asterisk 

items must be selected, single asterisk items of a type are mandatory, and the 

remaining types are optional to make an objective complete. 

Step 4 Repeat Step 3 until you have all the types desired.  

Step 5 Click on the Save button to save your selections. 

NOTE: 

You can also choose the "Search Objectives" link to find an 

existing objective to use or edit. 

Step 6 To Re-sequence the types of your objective click on the Resequence Items link. 

Drag and drop orange boxes to the location desired. Click on the Save button to 

save the new sequence. 

Step 7 To delete a selected type, highlight the item and click on the Delete button 

adjacent to it. Click on the Save button to complete your deletion. 

6.3.2.3.1 Lesson Objective Tabs 

There are three Lesson Objective tabs, they are: 

 General The General tab has the following elements: 

o Type This is the type of Learning Objective, Terminal or Enabling. This element is 

not editable from this tab. 

o Status This is the status of this Learning Objective; Incomplete, Complete, Locked 

for Review, or Approved. The status can only be changed from Incomplete when all 

Objective requirements have been met. 
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o Objective Development Block These are the blocks used to develop the Learning 

Objective, these work the same as in the Objective hyperlink in Lessons and Sections. 

 Skills Basis The Skills Basis tab lists the Skills Basis for the highlighted Learning 

Objective. This information is not editable from this screen. 

 Assessment The Assessment tab has the following elements: 

o Proficiency Level 

 Knowledge Proficiency Levels 

 KPL1 - Knowledge/Comprehension 

 KPL2 - Application/Analysis 

 KPL3 - Synthesis/Evaluation 

 Skill Proficiency Levels 

 SPL1 - Imitation 

 SPL2 - Repetition 

 SPL3 – Habit 

o Passing Criteria (%) The percentage of correct responses needed to pass. 

o Criticality Index The Criticality Index is derived from the following elements: 

 Criticality: 

 0 - Not Selected 

 1 - Not Critical 

 2 - Moderately Critical 

 3 - Critical 

 Difficulty: 

 0 - Not Selected 

 1 - Easy 

 2 - Moderately Difficult 

 3 - Difficult 

 Course Relation: 

 0 - Not Selected 

 1 - Indirectly Related 

 2 - Closely Related 

 3 - Directly Related 

6.3.2.4 Adding a Section to a Lesson 

Sections can be created from Tasks, Subtasks, or Steps contained in the database for the 
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Performance Requirements selected. If no data is present in the database for the Section being 

developed you can leave the Skill Basis blank. 

To add a Section  to a Lesson: 

Step 1 Click on the desired Lesson of your course in the COI tree structure.  

Step 2 Click on the New  icon. 

Step 3 Enter the title of the Section in the Section Title field. 

Step 4 Select the delivery method from the drop-down menu: Self Paced, Instructor Led, 

Blended, Lab, or EPSS. 

Step 5 In the Content Type field click on the drop-down arrow and select the type of 

objective you will develop: Concept, Fact, Principle, Procedure, or Process. 

A Section is referred to as a “topic” within the Lesson. The Section content 

(elements) varies depending on the type of Section selected. 

There are five types of Sections: 

 Concept – A class of items that shares common key features and is known 

by a common name. 

 Fact – Unique, one-of-a-kind types of information. 

 Process – A series of actions, changes, or functions that achieve an end 

result.  It often is used when you need to illustrate a flow of events that 

describes how something works. 

 Procedure – A sequential set of steps to be followed by one individual to 

accomplish a task or make decisions. Actions within the procedure must be 

done the same way each time within a given situation. 

 Principle – A procedural job task that requires judgment or when guidelines 

must be applied to a situation. 

If unsure as to which Content Type to select for a section, a Decision Wizard can be used. 

Click on the blue "?" next to the Content Type dropdown to activate the Wizard. Answer the 

"Yes" or "No" questions in the Wizard for each of the five content types. At the end of the 

questions, a percentage of each Content Type will be displayed. The user then has the option to 

select the Content Type determined by the Wizard, go back and adjust answers, or cancel the 

Wizard. 

NOTE: 

If in doubt about the type refer to the Navy ILE web site 

https://www.netc.navy.mil/ile/, select the tab for Policy and 

Guidance and refer to Navy ILE Instructional Content Style Guide: 

Interactive Multimedia Instruction & Instructor-Led Training, 

document, paragraph 1.5 Content Types. 

https://www.netc.navy.mil/ile/
https://navyile.fedsun.navy.mil/netcile/content/Navy%20ILE%20Instructional%20Content%20Style%20Guide_20060317.pdf
https://navyile.fedsun.navy.mil/netcile/content/Navy%20ILE%20Instructional%20Content%20Style%20Guide_20060317.pdf
https://navyile.fedsun.navy.mil/netcile/content/Navy%20ILE%20Instructional%20Content%20Style%20Guide_20060317.pdf
https://navyile.fedsun.navy.mil/netcile/content/Navy%20ILE%20Instructional%20Content%20Style%20Guide_20060317.pdf
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Step 6 Select the Cognitive Level from the drop-down menu: Apply or Remember.  

Step 7 Select the Skill Basis from the Skills Basis tab 

1. Click the Select Icon  . 

2. Expand the tree as needed to find the desired Duty, Task or KSATR, see 

Figure 6-17. 

3. Click the checkbox next to the desired Duty, Task or KSATR to select it. 

4. Click the OK button. 

5. Click the Save button. 

NOTE: 

If a Skill Basis was selected, when saving the option to use the 

linked JDTA item (for example Task) as the default wording for the 

learning objective will be available. Editing the objective will still 

be available. 

Step 13 Click on the  ISD Considerations link. 

Step 14 Click on the Edit button to input the desired ISD Considerations. Refer to Figure 

6-22. 

 

Figure 6-22. ISD Considerations Window 

To develop an Enabling Objective Statement (EOS) for the Section: 

Step 1 Click on the Section    title in the COI tree structure. 

Step 2 Click on Objective. The Objective development window will open. 

Step 3 In the Select Type field click on the drop-down arrow and select the desired type 

of entry to begin developing your objective. One or more of the double asterisk 

items must be selected, single asterisk items of a type are mandatory, and the 

remaining types are optional to make an objective complete. 
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Step 4 Repeat Step 3 until you have all the types desired.  

Step 5 Click on the Save button to save your selections. 

Step 6 To Re-sequence the types of your objective click on the Resequence Items link. 

Drag and drop orange boxes to the location desired. Click on the Save button to 

save the new sequence. 

Step 7 To delete a selected type, highlight the item and click on the Delete button 

adjacent to it. Click on the Save button to complete the deletion. 

6.3.2.4.1 Section Objective Tabs 

There are three Section Objective tabs, they are: 

 General The General tab has the following elements: 

o Type This is the type of Learning Objective, Terminal or Enabling. This element is 

not editable from this tab. 

o Status This is the status of this Learning Objective; Incomplete, Complete, Locked 

for Review, or Approved. The status can only be changed from Incomplete when all 

Objective requirements have been met. 

o Content Type This is the Learning Content Type of the Section; either Concept, 

Fact, Principle, Procedure, or Process. 

o Objective Development Block These are the blocks used to develop the Learning 

Objective, these work the same as in the Objective hyperlink in Lessons and Sections. 

 Skills Basis The Skills Basis tab lists the Skills Basis for the highlighted Learning 

Objective. This information is not editable from this screen. 

 Assessment The Assessment tab has the following elements: 

o Proficiency Level 

 Knowledge Proficiency Levels 

 KPL1 - Knowledge/Comprehension 

 KPL2 - Application/Analysis 

 KPL3 - Synthesis/Evaluation 

 Skill Proficiency Levels 

 SPL1 - Imitation 

 SPL2 - Repetition 

 SPL3 - Habit 

o Test Item Type The type of Test Item associated with the highlighted Learning 

Objective; True/False, Multiple Choice, Fill-In-The-Blank, Two-Column Matching, 

or Performance-based. 

o Passing Criteria (%) The percentage of correct responses needed to pass. 
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o Number of Test Items The number of Test Items associated with the highlighted 

Learning Objective. This only applies to Enabling Objectives. 

o Criticality Index The Criticality Index is derived from the following elements: 

 Criticality: 

 0 - Not Selected 

 1 - Not Critical 

 2 - Moderately Critical 

 3 - Critical 

 Difficulty: 

 0 - Not Selected 

 1 - Easy 

 2 - Moderately Difficult 

 3 - Difficult 

 Course Relation: 

 0 - Not Selected 

 1 - Indirectly Related 

 2 - Closely Related 

 3 - Directly Related 

6.3.2.5 To Approve/Reject an Accepted Module, Lesson, Section: 

Step 1 Click on the desired accepted module, lesson, or section of the course in the COI 

tree structure. 

Note: To set the status to Accepted, the content has to be Submitted and Accepted 

from AIM LO Module and updated in CPM from AIM LO Module. 

Step 2 Select the Approve or Reject button on the bottom of the right-hand screen. 

Note: Once a Module or Lesson has been approved, no lessons or sections can be 

added to it. A new Module or Lesson Version would have to be created first. 

Note: If you select Reject, a window opens for a required explanation to be 

entered. Click OK to save the explanation and Reject the content, resetting the 

Status to New for that content in CPM and Complete in AIM LO Module, or click 

Cancel to cancel the rejection process. 

Note: The Rejection explanation can be viewed in CPM by clicking on the 

History icon. 

6.3.2.6 To Create a New Version of an Approved Course, Module, Lesson, Section: 

Step 1 Click on the desired approved course, module, lesson, section of the course in the 
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COI tree structure. 

Step 2 Click on the Create New Version   icon. A new version is created, flagged, and 

ready to be edited. The Version drop-down allows the user to switch between the 

different available versions. To see the new version in AIM LO Module, the 

project will need to be exported from CPM and updated from EDE in AIM LO 

Module. 

6.3.2.7 Select Copy Module, Lesson or Section 

To reuse a Module, Lesson or Section from a different project, perform the following steps: 

1. Highlight the position in the tree where you want the new element. Remember, highlight 

Course for new Module, Module for a new Lesson, and Lesson for a new Section. 

2. Click on the Select Copy  Icon. 

3. Click on the desired element(s) checkbox in the right pane. 

4. Click the OK button. 

NOTE 

When using Select Copy it is important to note that the selected Module. Lesson or Section 

is NOT actually copied. A link is created between the original element and the new one. 

This means that any changes made to the new element will affect the original. Only users 

with Edit privileges to the original element can make changes. 

To find the original section, mouse-over the link or select the element and read the location. 

6.3.2.8 Linking a Module, Lesson, or Section 

Modules, Lessons, and Sections can be reused in other Projects, this process is known as 

linking. It is important to note that linking does not create a copy of the element, rather, it 

creates a link to the original element for reuse in a different project. This is significant because 

any changes made to the new linked element will also be reflected in the original element. To 

link an element follow these steps: 

Step 1. Highlight the desired element.  

Step 2. Click the Copy  icon. 

Step 3. Move to the Project where the element is to be used. 

Step 4. Highlight the element where you want the linked element to appear. Elements 

must be linked to like elements, Modules to Modules, Lessons to Lessons, 

and Sections to Sections. 

Step 5. Click the Paste  icon and select Link. Selecting Move will remove the 

element from its original location. 
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Once an element has been link there will be a Linked icon next to the element in the left 

pane. There will also be text in the right pane indicating the element is linked and giving the 

location of the original element. 

The original element will also show text indicating that there is an element linked to it and it will 

give the location of the linked element. 

6.3.2.9 Adding Assessments 

Assessments can be added to lessons and sections as needed to support the testing plan. These 

assessments are added by selecting Assessment vice New Lesson or Section. Assessments cannot 

be the first item in a lesson or section.  

6.3.2.9.1 To add an Assessment to a Lesson : 

Step 1 Click on the desired Module of your course in the COI tree structure. 

Step 2 Click on the New  icon. Select Assessment. Refer to Figure 6-23. 

 

Figure 6-23. New Lesson 

Step 3 Enter the title in the Assessment Title field.  

Step 4 Select the test type from the drop-down menu. 

Step 5 Select the status from the drop-down menu. 

Step 6 Enter the minimum passing score. 

Step 7 Select Retest from the drop-down menu. 

Step 8 Enter text in the Retest Criteria, as needed. 

Step 9  Click on the Save button. 
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Step 10 Click on the Test  ISD Considerations link. 

Step 11 Click the Edit button to add information for the appropriate ISD Considerations 

for the assessment. Refer to Figure 6-24. 

 

Figure 6-24. ISD Considerations for Lesson 

Step 12 Click on the Save button. 

Step 13 Click on the Test  Instructions link. 

Step 14 Click the Edit button to add information for the appropriate Test Instructions for 

the assessment. Refer to Figure 6-20. 

Step 15 Select the Objective(s) from the Objectives tab that will be assessed: 

1. Click the Select Icon . 

2. Click the checkbox next to the Objective(s). 

3. Click the OK button. 

4. Click the Save button.  

Step 16 Click on the Save button to save your Assessment. 

6.3.2.9.2 To add an Assessment to a Section : 

Step 1 Click on the desired Lesson of your course in the COI tree structure. 

Step 2 Click on the New  icon. Select Assessment. Refer to Figure 6-25. 
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Figure 6-25. New Lesson 

Step 3 Enter the title in the Assessment Title field.  

Step 4 Select the test type from the drop-down menu. 

Step 5 Select the status from the drop-down menu. 

Step 6 Enter the minimum passing score. 

Step 7 Select Retest from the drop-down menu. 

Step 8 Enter text in the Retest Criteria, as needed. 

Step 9  Click on the Save button. 

Step 10 Click on the Test  ISD Considerations link. 

Step 11 Click the Edit button to add information for the appropriate ISD Considerations 

for the assessment. Refer to Figure 6-26. 
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Figure 6-26. ISD Considerations for Lesson 

Step 12 Click on the Save button. 

Step 13 Click on the Test  Instructions link. 

Step 14 Click the Edit button to add information for the appropriate Test Instructions for 

the assessment. Refer to Figure 6-20. 

Step 15 Select the Objective(s) from the Objectives tab that will be assessed: 

1. Click the Select Icon . 

2. Click the checkbox next to the Objective(s). 

3. Click the OK button. 

4. Click the Save button.  

Step 16 Click on the Save button to save your Assessment. 

 

6.4 TOS/ASSESSMENT INFO TAB 

The left pane of the ToS/Assessment Info tab has the following columns: 

 No. This column indicates the Lesson/Section of the objective, for example, 1.0 would be 

the first Lesson, 1.1 would be the first Section of the first Lesson. 

 Objective Text This column lists the Learning Objective content. 

 SPL This column lists the Skills Proficiency Level associated with the Learning 

Objective. 
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 KPL This column indicates the Knowledge Proficiency Level associated with the 

Learning Objective. 

 #Items This column indicates the number of Test Items associated with the Learning 

Objective. 

 Index This column indicates the Criticality Index associated with the Learning Objective. 

 Passing% This column indicates the passing percentage required for this Learning 

Objective. 

The right pane has three tabs that are associated with the highlighted Learning Objective from the 

left pane, these tabs are: 

 General The General tab has the following elements: 

o Type This is the type of Learning Objective, Terminal or Enabling. This element is 

not editable from this tab. 

o Status This is the status of this Learning Objective; Incomplete, Complete, Locked 

for Review, or Approved. The status can only be changed from Incomplete when all 

Objective requirements have been met. 

o Content Type This is the Learning Content Type of the Lesson or Section; either 

Concept, Fact, Principle, Procedure, or Process. 

o Objective Development Block These are the blocks used to develop the Learning 

Objective, these work the same as in the Objective hyperlink in Lessons and Sections. 

 Skills Basis The Skills Basis tab lists the Skills Basis for the highlighted Learning 

Objective. This information is not editable from this screen. 

 Assessment The Assessment tab has the following elements: 

o Proficiency Level 

 Knowledge Proficiency Levels 

 KPL1 - Knowledge/Comprehension 

 KPL2 - Application/Analysis 

 KPL3 - Synthesis/Evaluation 

 Skill Proficiency Levels 

 SPL1 - Imitation 

 SPL2 - Repetition 

 SPL3 - Habit 

o Test Item Type The type of Test Item associated with the highlighted Learning 

Objective; True/False, Multiple Choice, Fill-In-The-Blank, Two-Column Matching, 

or Performance-based. This only applies to Enabling Objectives. 

o Passing Criteria (%) The percentage of correct responses needed to pass. 
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o Number of Test Items The number of Test Items associated with the highlighted 

Learning Objective. This only applies to Enabling Objectives. 

o Criticality Index The Criticality Index is derived from the following elements: 

 Criticality: 

 0 - Not Selected 

 1 - Not Critical 

 2 - Moderately Critical 

 3 - Critical 

 Difficulty: 

 0 - Not Selected 

 1 - Easy 

 2 - Moderately Difficult 

 3 - Difficult 

 Course Relation: 

 0 - Not Selected 

 1 - Indirectly Related 

 2 - Closely Related 

 3 - Directly Related 

6.5 REPORTS 

There are twelve reports that the CPM software will compile and display in a PDF file: 

• Training Project Plan 

• Course Training Task List 

• Table of Specifications 

• Curriculum Outline of Instruction 

• IMDP 

• Training Course Control Document 

• Testing Plan 

• Skill Basis 

• Objects With No Skills Basis 

• Project Status 
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• COI to Excel 

• Traceability Matrix 

When printing the TPP or TCCD reports and no CDP is specified, then no CCMM information 

will be printed. 
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7.0 REPORTS 

The Reports tab provides an area where you can print several types of reports for your Center. 

Refer to Figures 7-1 

 

Figure 7-1: Center Reports 

Highlight the desired report name and click on the print icon. The software will create the report 

for your Center and it will open in Adobe. You can save/print it from Adobe. 
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8.0 RESOURCES 

The Resources tab provides an area where you can view, add and edit resources for your Center. 

Refer to Figure 8-1 

 

Figure 8-1: Select Category 

To add a new resource: 

Step 1 Click on the desired resource category. Refer to Figure 8-1. 

 

Figure 8-2: Selected Resource Category 

Step 2 Click on the New                icon to add a new resource. Refer to Figure 8-2. 
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Figure 8-3: Adding a Hand Tool 

Step 3 Enter the required information for the CPM software, identified by an asterisk 

next to the field. Identify other information if necessary. 

Step 4 Click on the Save button to save your entry to the database. 

The software will provide fields for identification information for each type of Resource as 

follows: 

All equipment related categories ask for the same information as identified in Figure 8-3. The 

following categories are equipment related: 

 Calibration 

 Computers 

 Consumables 

 Equipment 

 Hand Tools 

 Maintenance Trainers 

 Miscellaneous Materials 

 Ordnance 

 Prefaulted Modules 

 Refurbishments 

 Special Tools 

 Support Equipment 

 Test Equipment 
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 Test Equipment 

 Trainer Materials 

 Training Devices 

 Training Equipment 

Equipment related categories provide fields to identify the following information: 

 Part Number 

 Nomenclature 

 Source 

 AAC - Acquisition Advice Code 

 Unit Cost 

 Unit of Issue 

 CAGE - Commercial and Government Entity 

 Technical Reference 

 SM&R - Source Maintainability and Recoverability 

 COG - Cognizant (activity) 

 SMIC - Special Material Identification Code 

 NINN/NSN – Stock Number 

 MACOCO - Manufacturing Cost Code 

Photographs and Wall Charts contain fields to identify Number, Title, Source, and Figure 

Number. Refer to figure 8-4. 

 

Figure 8-4: Adding a Wall Chart 
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Films and Videos contain fields to identify Number, Title, Running Time, and Source. Refer to 

figure 8-5. 

 

Figure 8-5: Adding Film 

IETM (Interactive Electronic Technical Manual) and Publications contain fields to identify 

Number, Title and Source. Refer to figure 8-6. 

 

Figure 8-6: Adding an IETM 

IMM (Instructional Media Material), Slides, and Transparencies contain fields to identify 

Number, Title, Source, and Description. Refer to figure 8-7. 
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Figure 8-7: Adding an IMM 

Software contains the following fields: Refer to figure 8-8. 

 Number 

 Type 

 Vendor 

 Software type 

 Cost 

 Version 

 Date 

 Reference Information 

 Contact Information 

 Minimum System Requirements 
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Figure 8-8: Adding Software 
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9.0 ADMIN 

The Admin tab provides an area where the System and Center Administrators can add and edit 

CPM User information, identify User and Project Roles, identify Centers, edit TTA Data and 

create, edit, print and delete announcements. 

9.0.1 Gatekeeper 

Gatekeeper functionality has been incorporated into CPM to reduce redundancy and standardize 

data elements. Currently Gatekeeper functions are being performed by NETC and AIM 

personnel, eventually this will shift to Center Administrators. 

Gatekeeper functionality requires a role with "Administer" privilege for both the Data and 

Resources tabs. 

Gatekeeper functionality includes the following: 

 Linked Items Report 

 Unlinked Items Report 

 Similar Items List 

 Replace Function 

The Linked Items Report will list all Centers linked to an item in the Data and Resources tabs. 

The Unlinked Items Report will list all items in the Data and Resources tabs not currently linked 

to a JDTA or an Objective in the Curriculum Outline of Instruction. Both reports will list the 

following information: 

 Type 

 Item 

 Date 

 Center (if linked to a center) 

The Similar Items List is used to check for possible duplicate entries, and the Replace Function is 

used to eliminate those duplicates. 

9.1 USERS 

When the Admin tab is selected the Users menu item is selected by default. The window opens to 

reveal information about Active, Pending, Inactive, and Currently Logged in Users can be 

selected by clicking on the down arrow and selecting the desired users. 
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Figure 9-1 Users 

9.1.1 Active Users 

The Active Users menu provides an area where the Administrator can add New users and 

Deactivate users. Refer to figure 9-1. 

To add a New User: 

Step 1 Click on the Add icon . Refer to Figure 9-2. 

 

Figure 9-2  Adding User 

Step 2 Enter the required information in the fields marked by an asterisk*.  

Step 3 Click on the Save button. 

NOTE: 

If adding a User with multiple center access a Role must be 

specified for each Center. It may be the same Role, but it must be 

assigned for each Center. 
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To Change a Password for a User: 

Step 1 Click on the user in the Active Users list.  

Step 2 Click on the Edit button. 

Step 3 Click on the Change Password button. 

Step 4 Enter the new password in the Password field. 

Step 5 Enter the password again in the Verify Password field.  

Step 6 Click on the Save button. 

To Deactivate a User: 

Step 1 Highlight the user. 

Step 2 Click on the Deactivate icon  

Step 3 When prompted “Are you sure you want to deactivate this user?” click on OK. 

9.1.2 Pending Users 

Pending Users originate from users that request an account from the login window of the CPM. 

When the user submits the information an Email is automatically sent to their Email address from 

the System Administrator stating “This is to verify your CPM account request has been submitted 

at https://cpm-aim.ncdc.navy.mil. You should be receiving an email within the next couple of 

days with a status of your request. Please feel free to contact me with any questions you may 

have about this request.” 

To change a password for a Pending User: 

Step 1 Click on the user in the Pending Users list. 

Step 2 Enter the new password in the Password field. 

Step 3 Enter the password again in the Verify Password field.  

Step 4 Click on the Save button. 

To Accept a Pending User: 

Step 1 Click on the user in the Pending Users list. 

Step 2 Click on the Accept button. This will place the User in the Active Users list. An 

Email will be sent to the user automatically from the System Administrator with 

login, password and other amplifying information. 
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To Reject a Pending User: 

Step 1 Click on the user in the Pending Users list.  

Step 2 Click on the Reject button. 

Step 3 At the prompt “Are you sure you want to delete this user?” click on OK. 

9.1.3 Inactive Users 

To Delete an Inactive User: 

Step 1 Click on the user in the Inactive Users list.  

Step 2 Click on the Delete icon . 

Step 3 At the prompt “Are you sure you want to delete this user?” click on OK. 

To Activate an Inactive User: 

Step 1 Click on the user in the Inactive Users list.  

Step 2 Click on the Activate icon . 

Step 3 At the prompt “are you sure you want to Activate this user?” click on OK. 

To Change a Password for an Inactive User: 

Step 1 Click on the user in the Inactive Users list.  

Step 2 Click on the Change Password button. 

Step 3 Enter the new password in the Password field. 

Step 4 Enter the password again in the Verify Password field.  

Step 5 Click on the Save button. 

9.1.4 Currently Logged in Users 

A list of users that are currently logged into the CPM will appear when the Currently Logged in 

Users menu item is selected. 

9.2 ROLES 

The purpose of the Roles menu item is to add and define the User Role nomenclature, level of 
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access to Data, OCCSTDs, JDTA, Projects, Resources, and Reports and to identify Leaders of 

Projects and types of Administrators. You can also identify, add, and define Project Roles. 

9.2.1 User Roles 

 

Figure 9-3: User Roles 

To add a new user role: 

Step 1 Select User Roles. 

Step 2 Click on the New icon. 

Step 3 Enter the Role Title in the field provided. 

Step 4 In the Data, OCCSTDs, JDTA, Projects, Reports and Resources fields, from the 

drop-down menu in each field, select None, View, Edit, or Administer. There is 

also an additional option for the JDTA field. This option is Create, which allows a 

user with this role to create any JDTA content under their center, including 

Occupations. A user with this option will be allowed to edit only that existing 

content within the Center that they created, unless granted extended privileges 

under one or more Occupations within the Center. 

Step 5 In the Administration field, from the drop-down menu, select None, Center 

Administrator, or System Administrator 

Step 6 Click on the Save button to save the User Role. 
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9.2.2 Project Roles 

 

Figure 9-4:  Project Roles 

To add a new project role: 

Step 1 Select Project Roles. 

Step 2 Click on the New icon. 

Step 3 Enter the Role Title in the field provided. 

Step 4 In the remaining fields, from the drop-down menu in each field, select View, Edit, 

or Administer for: 

 Project Data 

 Team Members 

 Performance Requirements 

 TPP/TCCD 

 Assignments 

 Curriculum Outline of Instruction 

Step 5 Click on the Save button to save the Project Role. 

9.3 CENTERS 

The Centers menu item provides an area where the Administrator can create, edit, and delete 

Centers identified in the database. Refer to Figure 9-5. 

 

Figure 9-5: Centers 
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To add a New Center: 

Step 1 Select the Centers menu item.  

Step 2 Click on the New icon. 

Step 3 Enter the Name of the Center in the field provided. 

Step 4 Click on the Save button to save your entry to the database. 

To delete a Center: 

Step 1 Select the Centers menu item.  

Step 2 Click on the Center to be deleted. 

NOTE: A Center cannot be deleted if Users or Occupations are assigned to the Center.  

Step 3 Click on the Delete icon. 

Step 4 At the prompt “Are you sure you want to delete this Center?” click on the OK 

button. 

9.4 AGENCIES 

The Agencies menu item provides an area where the Administrator can create, edit, and delete an 

Agency identified in the database. Refer to Figure 9-6. 

 

Figure 9-6: Agencies 

To add a New Agency: 

Step 1 Select the Agencies menu item.  

Step 2 Click on the New icon. 

Step 3 Enter the Name and Address of the Agency in the fields provided.  
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Step 4 Click on the Save button to save your entry to the database. 

To delete an Agency: 

Step 1 Select the Agencies menu item.  

Step 2 Click on the Agency to be deleted. 

Step 3 Click on the Delete icon. 

Step 4 At the prompt “Are you sure you want to delete this Agency?” click on the OK 

button. 

9.5 TRAINING SITES 

The Training Sites menu item provides an area where the Administrator can create, edit, and 

delete a Training Site identified in the database. Refer to Figure 9-7 

 

Figure 9-7: Training Sites 

To add a New Training Site: 

Step 1 Select the Training Sites menu item.  

Step 2 Click on the New icon. 

Step 3 Enter the Name and Address of the Training Site in the field provided.  

Step 4 Select the associated Center from the drop-down menu. 

Step 5 Click on the Save button to save your entry to the database. 

To delete a Training Site: 

Step 1 Select the Training Sites menu item.  
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Step 2 Click on the Training Site to be deleted.  

Step 3 Click on the Delete icon. 

Step 4 At the prompt “Are you sure you want to delete this Training Site?” click on the 

OK button. 

9.6 TRAINING TASK ANALYSIS (TTA) DATA 

The TTA menu item provides an area where the Administrator can create descriptive statements 

for task identification. The analysis data is comprised of the following items: Refer to Figure 9-8. 

 Safety Hazard Security 

 Criticality of Performance 

 Task Delay tolerance 

 Frequency of Performance 

 Probability of Inadequate Performance 

 Difficulty of Performance 

 Task Learning Difficulty 

 Percent Performing 

 Percent of Time Spent on Performing 

 Immediacy of Performance 

 Intervention 

 Task Level 

 Status of Training 

 Type of Training 

 

Figure 9-8: TTA  

To add a New descriptive statement for a TTA item: 

Step 1 Select the TTA menu item. 



Content Planning Module (CPM) User’s Manual  ADMIN 

Release 5.15  9-10 

Step 2 From the drop down menu select the desired TTA item.  

Step 3 Enter the text of the descriptor in the Name field provided.  

Step 4 Enter the Sequence number if different from the default.  

Step 5 Click on the Save button to save your entry to the database. 

To delete a descriptor from a TTA item: 

Step 1 Select the TTA menu item. 

Step 2 From the drop down menu select the desired TTA item.  

Step 3 Click on the descriptor to be deleted. 

Step 4 Click on the Delete icon. 

Step 5 At the prompt “Are you sure you want to delete this item?” click on the OK 

button. 

9.7 IN-USE 

The In-Use tab is used to clear In-Use flags that have been generated erroneously. To remove the 

In-Use flag, follow the steps below: 

Step 1 Click on the In-Use element you wish to remove.  

Step 2 Click on the Delete icon. Refer to Figure 9-9.  

Step 3 Confirm the deletion of the In-Use flag. 

 

Figure 9-9: In-Use Flag Removal 

9.8 ANNOUNCEMENTS 

The Announcements menu item provides an area where the Administrator can create, edit, and 

delete System Announcements that are displayed on the CPM User’s Homepage. Refer to Figure 

9-10. 
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Figure 9-10: System Announcements 

To create a System Announcement: 

Step 1 Click on the Admin tab. 

Step 2 Click on the Announcements menu item. 

Step 3 The two icons in the Announcements pane are New        and Delete . Click on 

the New icon. 

Step 4 Click on the calendar icon and select the Expiration Date.  

Step 5 Enter the subject text in the Subject field. 

Step 6 Enter the announcement information in the Content field.  

Step 7 Click on the Save button when complete. 

After the Announcement is saved you can edit it by clicking on the announcement in the left 

hand pane. This will open the Announcement in the right hand pane and it is editable. 

An Announcement can be deleted by clicking on the announcement no longer required and 

clicking on the Delete icon. When prompted with “Are you sure you want to delete this 

announcement?” click on OK. 

9.9 FIELD-LEVEL HELP 

Administrators can populate Field-Level Help Text and Tool Tips that are visible when moused 

over. When the Field-Level Help tab is selected the left pane displays a table of pages outlined in 

blue and under each page are the field where help can be added. On the right side of each field 

are two symbols separated by a '/'. This symbols are either a '-' indicating there is currently no 

help text or an '*' indicating there is help text. The first symbol is associated with the Help text, 

the second symbol is associated with the Tool Tip. 
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9.10 DEFAULT TEXT 

The Default Text page is used by Administrators to create text that may be used repeatedly in 

announcements or e-mails. 

9.11 CONFIGURATION 

The Configuration page contains system-wide settings, access to this page is restricted and 

setting should only be changed by trained personnel. 

9.12 TOOLS 

The Tools page contains tools for system programmers. Access to this page is protected by an 

additional password and username. 
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